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Introduction

Dragon Medical Enterprise Network Edition for healthcare enterprise environments provides a central

server (the Nuance Management Server) along with multiple local or remote speech recognition client

machines where healthcare providers dictate. Dragon Medical Enterprise takes advantage of distributed

processing across servers and workstations for greater efficiency.

This Dragon Medical Enterprise Network Edition Installation Guide takes you through the process of install-

ing the various server and client components of Dragon Medical Enterprise Network Edition, connecting

them to a database that stores your organization's data, and installing/setting up Dragon Medical Clients

that work with both the NMS Server and the other servers and components of the network.

Before you use this manual to install Dragon Medical Enterprise Network Edition, you should determine

your network needs and be sure you have the required software by reading the Dragon Medical Enter-

prise Network Edition Planning and Deployment Guide. That guide takes you through the process of plan-

ning deployment of a Dragon Medical Enterprise Network, showing you how to determine the number of

servers and other equipment you will need and how to prepare that equipment for installation of

Dragon Medical Enterprise.

Note:

Some DME product features might have changed since this manual was printed. A current version of

this book is always available on Nuance's documentation portal, in PDF format. Contact your

Nuance representative about accessing that portal to retrieve the latest copy.
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Creating single user account to run all
services under

Before you begin the installation, you create two user accounts, one for DME services to run

under (see next immediate Caution) and one to install the software (see next section).

Caution:

Before you carry out this procedure, you must create a single Windows administrator account

to run all services under (named something like NMSapps) that meets the following require-

ments:

n Is in the organization's domain or, for a single server configuration, the workgroup.

n Never expires.

n Has a password that never expires (does not have to be changed at regular intervals).

n Has rights to install software and Windows services on the server.

n Has rights to create and start a Windows service on the server.

VERY IMPORTANT:

n Has full read/write access rights to all other servers within the DME Network.

n Has full read/write access to the database server (if it is on a separate server).

n Has full read/write/modify permissions to access the directory hosting the master user profiles.

You must set up this account with Log on as Service rights so that it can launch the services

when the installation is complete.

Creating/selecting user account to
install all services

Caution:

Before you carry out this procedure, you must create a single Windows administrator account

to install all DME and related services. That account must meet these requirements:

n Has rights to install software and Windows services on the server.

n Has rights to create and start a Windows service on the server.

n Has full read/write access to the database server.

VERY IMPORTANT:

You must use this account to install the database software and all servers in the DME product.
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DVDs in the Dragon Medical
Enterprise Network Edition package

When you open the Dragon Medical Enterprise Network Edition product package, you should find a

license certificate detailing the licenses you purchased along with these DVDs (you should have

received the license key from Nuance through email):

n Nuance Management Server Software and Documentation

n Nuance Management Server MS SQL 2008

n Dragon Medical Enterprise Network Edition Client Software

The Nuance Management Server Software and Documentation DVD includes installers for servers and

related software, plus the product documentation in PDF format. Here are the installers included:

n Nuance Management Server

n Nuance Security Certificates

n Nuance Profile Optimizer

n Dragon Medical SDK Client

What you should know to carry out
this installation

Before you begin the installation, you should evaluate your own system installation skillset. To

select the appropriate hardware and install the Dragon Medical Enterprise Network Edition server and

client software, you should have adequate skills and experience to:

n Create a network domain/user account with full read/write access rights across all servers

n Create databases with SQL Server

n Set up backup plans for SQL Server

n Create and securely administer a Windows share

n Set Windows user rights and directory permissions

n Set up and configure Internet Information Services (IIS)

n Securely administer IIS (if using web server for master user profiles)

n Order, receive, and install SSL certificates in IIS (if using secure web server for master user

profiles)

n Edit XML configuration files

n Manage Windows Services
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Assigning access to servers, clients,
master user profiles across network

Caution:

Windows accounts that all NMS and Profile Optimizer processes on the network run under, even

the Dragon Medical Client, must have read permission to the following:

<Drive Letter>:\Program Files\ folder and all subfolders

Assigning permissions to NMS and Profile Optimizer
component files
To ensure all NMS and Profile Optimizer processes can interact with one another, during the instal-

lation you set up a single administrator level account (name it something like NMSapps) that all

the software will be running under and give full access rights across all servers to the directories

where you install the software. The software these conditions apply to includes:

n NMS Server

n NMC Console

n NMS SQL Database

n Profile Optimizer Server

n Profile Optimizer Database

n Each Profile Optimizer Speech Node

Caution: Run All Services under the same Windows user account

All services should run under this same Windows administrator level account with full access

rights across all servers and the master user profiles directory.

Directories where the components are installed should have full read/write/modify permissions.

Caution: Ensure Full access to the Master user profiles directory

It is especially important that the account that NMS and Profile Optimizer components run under

has complete read/write/modify access to the master user profiles directory. If the servers and

Speech Nodes cannot access the master user profiles, the DME product cannot function properly.

Each windows user account that logs in to the Dragon Medical Client workstation should also have

access to the master user profiles that allows reading profiles and writing to/modifying profiles, an

action the Dragon Medical Client takes frequently to keep profiles current.
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Caution: Regarding Privacy of Patient Data

To protect the privacy of patient data and the integrity of the master user profiles, you should not

give Windows user accounts of Dragon Medical Clients rights to log in to the master user profiles

machine; the Dragon software writes to and modifies the profiles in the background.

Assigning permissions to master user profiles
Caution:

Be sure that when you set up the master user profiles directory, you locate it either on a Windows

machine or on a device connected to a Windows machine with .NET Framework 3.5 SP1

installed on it and that the machine is in the same Windows domain as your DME servers.

To ensure every dictating healthcare provider has appropriate access to files (such as his or her

user profile), you must give full read/write/modify permissions to all files and directories housing

the master user profiles for healthcare providers that dictate on that client or allow the same level

of access to the master user profiles through an http or https connection. This level of per-

mission/access ensures that when the provider dictates, the software can interact with the master

user profiles effectively.

Assigning folder permissions to Dragon Medical
Enterprise server and client files
After you complete the server and client installations, you must assign particular levels of per-

missions to certain folders that Dragon Medical Client reads from and writes to when processing

speech.

NMS Servers/NMS and Profile Optimizer Databases:

<Drive Letter>:\Users\All Users\Application Data\Nuance folder and all

subfolders:

All users must have read, write, and modify permissions.

<Drive Letter>:\Program Data\Application Data\Nuance folder and all

subfolders:

All users must have read, write, and modify permissions.

<Drive Letter>:\Program Files\Nuance folder and all subfolders:

All users must have read permission.
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Dragon Medical Client workstations (Windows 7, XP, and Vista):

<Drive Letter>:\Program Data\Nuance folder and all subfolders:

All users must have read, write, and modify permissions.

<Drive Letter>:\<Windows_user_ID>\AppData\ folder and all subfolders:

All users must have read, write, and modify permissions.

<Drive Letter>:\Documents and Settings\All Users\Application

Data\Nuance folder and all subfolders:

All users must have read, write, and modify permissions.

Assigning Dragon Medical Clients access to registry
keys
You must assign particular levels of access to certain registry key settings. You assign these rights

to all Windows user accounts for all dictating healthcare providers using Dragon Medical Client .

Dragon Medical Client workstations:

Workstation Windows user accounts that Dragon Medical runs under must have rights to update the

registry in order to read/write to particular keys in the registry:

HKEY_LOCAL_MACHINE\SOFTWARE\Nuance

HKEY_CURRENT_USER\SOFTWARE\Nuance

Ensuring appropriate ports are open
on your hardware firewall

On the DME Network, particular ports must be open to ensure the free flow of data between the

various places it is required to travel. A complete list of all the ports that should be open is given

in the table at the end of this section.

All of the ports listed in the table must be opened on the hardware firewall to ensure that firewall

does not block transmission of data and bring the network to a halt.

Ports to be opened on client/servers and hardware
firewalls of DME Network
n Ports between Dragon Medical Client workstations and theirNMS Server

n Ports between Dragon Medical Client workstations and the Master User Profiles Server

n Ports between workstations where you expect to run NMC Console and NMS Server

n Ports between NMS Server and its database if that database is on a separate server

n Ports between Profile Optimizer Server and its database if the database is on a separate server
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n Ports between NMS Server and Profile Optimizer Server

n Ports between Profile Optimizer and each Speech Node machine

n Ports between each Speech Node machine and the Master User Profiles Server

n Ports between each NMS Server and the Nuance Update and License Servers

n All ports mentioned above on all hardware firewalls protecting the network

Summary: Ports to be opened on Client/Servers and hardware firewalls of DME Network

Hardware
Firewalls

NMS
Server

Profile
Optimizer
(Opened
for you,
but
verify)

MasterUser
Profiles
Server

Dragon
Medical
Client
Wksts.

NMS
Server
SQL
Database

Ports
(Server,
Client,
or Other
Hardware
That Port
Opens
Communi-
cation
with)

Open all
ports
named in
this table.

8731
8051
433 & 80
(Nuance Update/
License Servers)
1433
(NMS SQL DB)
808 (Profile Opti-
mizer)

8000
8001
905

80
(profiles on
server or http
web server)
443
(profiles on
SSL web
server)

80
(profiles on
server or
http web
server)
443 (pro-
files on SSL
 web server)

1433
(NMS Servers
on separate
physical
servers)

Turning off Automatic Updates
After you set up each physical server or workstation you plan to use in the DME Network, be sure

to turn off Windows Automatic Updates. You should be qualifying each update Windows sends

by installing it first on a single test machine of the network and updating other machines on the

network only after you determine that it clearly will not disrupt the network.

Even if you have determined an update is not going to negatively affect the network, you still

should install the update during off-hours and, if required, reboot each machine during those

hours to ensure that requests to reboot do not disrupt the DME servers or workstations during

peak hours of dictation.
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Anti-Virus recommendations
Nuance recommends anti-virus software on all Dragon Medical Enterprise Network Edition servers and

clients to protect the system from potential downtime due to viruses. However, be aware of the

recommended restrictions.

You should exclude from the anti-virus scan any files found in the folders indicated below or with

the extensions listed below.

On NMS Servers, Profile Optimization Server, SQL Database Server:

n Nuance folder and all subfolders

n Files with these extensions:

DAT, DRA, ENH, INI, LCK, LOG, NWV, SIG, TXT, USR, VER, VOC, WAV

Dragon Medical Client Workstations (Windows 7, XP, and Vista):

n C:\Program Data\Nuance\ folder and all subfolders

n C:\<Windows user_ID>\AppData\ folder and all subfolders

n C:\Documents and Settings\All Users\Application Data\Nuance

folder and all subfolders

n C:\Documents and Settings\Windows user_ID\Local Settings\Temp

folder

n Files with these extensions:

BD, BIN, DAT, DVC, ENH, GSB, GRM, GRX, INI, LCK, NWV, SIG, SVC, USR, VER,

VOC, WAV, XML, LOG

Recommended virtual memory
settings

Nuance recommends that you set virtual memory to particular levels on servers and workstations

in the Dragon Medical Enterprise network.

Server Virtual Memory:

Nuance recommends that the virtual memory for all servers be set to three times the physically

installed RAM.

Dragon Medical Client Workstation Virtual Memory:

Set Virtual Memory to 4092 in Windows Server 2008 or 2003 servers, or to the maximum pos-

sible setting on workstations that have 4 GB of RAM.
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Allocating disk space for logs
The Profile Optimizer Speech Node generates two log files for each ACO and LMO task it carries out:

n Dragon log file—Dragon Medical SDK Client writes this file

n Speech Node service log file—Profile Optimizer services write these files

(You can view both the Dragon log files and the Speech Node service log files through the NMC

 Console.)

The NMS Server generates one log file for each user:

n Windows communication foundation service log files

The NMS Server stores up to the last 10 MB of logs generated, a maximum of 50 log files for the

entire server, before purging the oldest files and replacing them with newer ones as it generates

them.

The Dragon log and Speech Node service log files are generally between 3 and 5 KB each. The Pro-

file Optimizer Server stores them for 30 days. Although the log files could be larger, they are stored

in a zipped format and compress very well. If you run an optimization process for every provider

every day and have 500 providers, if every log were as large as 5 KB, all of those logs would still

use only 2.5 MB of storage space and in 30 days that would become 75 MB of storage space. After

30 days, the Profile Optimizer purges old log files, so the storage requirements do not grow sub-

stantially.

Storage space for all of these logs is relatively inconsequential; however, if you expand the number

of providers in your organization, it is always best to take into account storage requirements for all

generated files.

If you call Technical Support, you might be asked to provide any of these logs to help Nuance

engineers work on any issues with your DME Network.

To access your Dragon log files, refer to the Nuance Management Server Administrator Guide.
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Checklists — Installing Nuance
Management Server/other DME
servers

Installing Operating System software
On each physical server where you plan to install NMS components,

Profile Optimizer components, or either of their databases:

Install 2008 Standard or Windows Server 2003 (minimum SP2 required).

Install all available Windows Updates and service packs.

Decide to work in Active Directory

Decide if you are going to be using NMS Server in the Active Directory Services interface.

Creating required account

Create single Windows administrator level account to run all DME services

___(call it something like NMSapps) and provide full access across all DME servers

___and the master user profiles directory. Use this account to run all services, including

___SQL Server services, so that all servers run under the same account. You can also use this

___account to install all software on the DME Network, but you can also make a separate

___account that meets less stringent requirements.

Refer to Creating single user account to run all services under on page 2 and Creating/selecting user account to

install all services on the same page.

Installing database software

Install SQL Server 2008 or 2003 SP2.

If you are using Active Directory Services, be sure to selectMixed Mode authentication.

___Otherwise, Nuance recommends you select Windows authentication.

Refer to Installing SQL Server 2008 on page 32.

Refer to Setting up NMS Server to run in Active Directory Services on page 192.
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Installing NMS Server, Console, and Database

Gather information you need:

Name or IP address of machine for this server: _________________________

Name or IP address of database server: _____________________

Name or IP address of machine to host master user profiles or URL to web

___server or SSL web server to host master user profiles: ___________________

Name or IP address Profile Optimizer Server: __________________________

Your customer ID ________________________________

Install prerequisiste software:

Install .NET Framework 3.5 SP1 and all available updates.

Refer to Installing prerequisite software for NMS Server on page 28.

Install Internet Information Services Version 7.0 or 7.5 on Windows Server 2008

___or Version 6.0 on Windows Server 2003.

Install the PowerShell feature.

Refer to Installing prerequisite software for NMS Server on page 28.

Install the NMS Server, Database, and Console:

Run the DME Nuance Management Server and Console installation wizard to install the

___NMS Server and NMC Console

Enter your customer ID.

Enter server name or IP address of NMS SQL Database.

Enter SQL Server Login (sa) and password.

Enter information about user account that will run all DME servers.

Enter server name or IP address of Profile Optimizer Server.

Refer to Installing Nuance Management Server and Console on page 40.

Open required ports on NMS Server and hardware firewalls:

Open these ports: 8730, 8051, 433 and 80.

Open 1433 on both NMS Server and Database Server.

Open 808 for communication with Profile Optimizer Server.
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Installing Profile Optimizer Server, Speech Nodes,
and Database

Gather information you need:

Name or IP address of machine for this server: _________________________

Name or IP address of database server: ______________________

___or Database connection string for SQL server authentication:

__________________________________

Name or IP address of machine to host master user profiles or URL to web

___server or SSL web server to host master user profiles: __________________

Path to where you want Dragon logs written (if not the default):

____________________________

Path to where you want Profile Optimizer logs written (if not the default):

_____________________________

To install Profile Optimizer Server & Speech Node on same machine:
Install prerequisiste software for Profile Optimizer Server:

Install .NET Framework 3.5 SP1 and all available updates.

Install prerequisiste software for Profile Optimizer Speech Nodes:

Install .NET Framework 3.5 SP1 and all available updates.

Only on machines where Speech Nodes will run in an operating system other than Windows

Server 2008, Install Windows Installer 3.1 or later.

On all machines where Speech Nodes will run, install Dragon Medical SDK Client .

Refer to Installing prerequisite softwarefor Profile Optimizer Server on page 53 and Installing additional pre-

requisite software for Speech Nodes on page 55

Create folder for the Profile Optimizer Database Files:

On machine where database will reside, create folder for the Profile Optimizer database files.

Install the Profile Optimizer Server, Database, and Speech Node:

Run the DME Profile Optimizer Installer wizard.

Select both check boxes on the Custom Settings page of wizard.

Enter information about user account that will run all DME servers.

Set paths to logs.
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EnterNMS Server name and database server name/authentication type.

Enter full path to database files folder.

Refer to Installing Profile Optimizer Server with or without Speech Nodes on same machine on

page 57.

To install Profile Optimizer Server without Speech Node on machine:

Nuance recommends a configuration where Speech Nodes are on their own machines or virtual

machines for most DME installations.

Install prerequisiste software for Profile Optimizer Server:

Install .NET Framework 3.5 SP1 and all available updates.

Refer to Installing prerequisite softwarefor Profile Optimizer Server on page 53.

Create folder for the Profile Optimizer database files:

On machine where database will reside, create folder for the Profile Optimizer database files.

Install the Profile Optimizer Server and database:

Run the DME Profile Optimizer Installer wizard.

Select only Profile Optimizer Server check box on Custom Settings page.

Enter information about user account that will run all DME servers .

Set paths to logs.

EnterNMS Server name and database server name/authentication type.

Enter full path to database files folder.

Refer to Installing Profile Optimizer Server with or without Speech Nodes on same machine on

page 57.

To install Profile Optimizer Speech Node alone on machine
or virtual machine:
Install prerequisiste software for Profile Optimizer Speech Node:

Install .NET Framework 3.5 SP1 and all available updates.

Install Windows Installer 3.1 or greater on machine.

Install Dragon Medical SDK Client on machine.

Refer to Installing additional prerequisite software for Speech Nodes on page 55
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Install Profile Optimizer Speech Node:

Run the DME Profile Optimizer Installer wizard.

Select only Profile Optimizer Speech Node check box on Custom Settings

___page.

Enter information about user account that will run all DME servers.

Set paths to log.

Enter the name of the physical server where the Profile Optimizer Server

___associated with this Speech Node resides.

Refer to Installing Profile Optimizer Speech Nodes on independent machine(s) or virtual

machine(s) on page 65.

Open required ports on Profile Optimizer Server and hardware fire-
walls:

Open these ports: 8000, 8001, 905.

Checklists — Setting up Active
Directory Services

To set up yourNMS Server to run in Active Directory Services you should take particular actions

during each step of the DME installation and NMS Server setup process. The steps that require

you take action are named in the headings below.

For details on each step, refer to Setting up NMS Server to run in Active Directory Services on page 192.

Installing SQL Server 2008

SelectMixed Mode authentication for accessing database.

Creating NMC Administrator Account for Active
Directory Administrator
To create anNMC Administrator user account for the Active Directory Administrator:

If you have not already done so, install the NMS Server.

Install the Nuance Certificates on any workstation where you want to log in through the

___NMC Console. Refer to Installing Nuance certificates on page 74.

Log in through the NMC Console using the login and password that Nuance provides.

14
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Create a user account for the Active Directory administrator (see the

___Nuance Management Server Network Edition Administrator Guide for details on setting up

___user accounts). You can add this account to the default NMC Administration group

___that comes with the product.

(Optional, as you can create them later) Create all other user accounts, adding some to the

___default NMC Administration group that comes with the product and others to the

___ default Dragon Medical group that comes with the product.

Enabling Active Directory and setting connection
string

Configure NMS Server for Active Directory inNuance.NAS.Server.exe.config file.

Logging Out and logging back in

Log out of the NMS Server.

Stop and restart the Nuance Management Service.

Log back in through the NMC Console as Active Directory administrator.

Revoke the NMC Adminstrator license of the original admin user account, as it

___does not work in Active Directory.

Creating Single Sign-On user accounts (optional)
You need to create these accounts before you can associate a user account with an already existing

upgraded master user profile.

Create Active Directory user accounts/logins.

Create Single Sign-On user accounts with same login name as their Active Directory accounts.

Refer to Setting up providers to log in only once by implementing Single Sign-On on page 1.

Continue to Configure NMS Server as Active
Directory Administrator

Follow instructions in Nuance Management Server Administrator Guide.
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Checklists — Starting Nuance
 Management and other DME servers

Services should start as soon as the servers are installed. To verify that the NMS Server is running

and ensure it can talk to the Speech Nodes:

Install Nuance Certificates on each machine where you plan to run the NMC Console.

Verify that you can log in to the NMC Consoleusing the supplied login and password.

Ensure that the NMS Server can communicate with Profile Optimizer Speech Nodes.

Refer to Installing Nuance certificates on page 74Logging in to the NMS Server through the NMC Console

on page 77, and

Ensuring NMS Server can communicate with Speech Node(s) on page 79

Verifying server services are running

Check for the status of each of the following services in the Services dialog box on cor-

responding physical servers:

Nuance Management Service

Profile Optimizer Core Services

Profile Optimizer NMS Integration

Profile Optimizer Host Manager

Profile Optimizer Speech Node

If any service is not running, start that service.

Refer to Starting Nuance Management Server and Profile Optimizer Server services on page 80.

If you are planning to use Active Directory Services

Proceed to Checklists — Setting up Active Directory Services on page 14.
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Checklists — Setting up file server to
host master user profiles

Select a machine to host the master user profiles.

Be sure that the machine is a Windows server or workstation with .NET Framework 3.5 SP1

___installed and that the machine is in the same Windows domain as your DME servers.

If you are using a RAID array or other storage device, be sure that it is connected to a

___server or workstation running Windows with .NET Framework 3.5 SP1 installed and

___that the machine is in the same Windows domain as your DME servers.

Create top level master user profile directory on the host.

For each site, create a subdirectory under the master user profile directory.

Share the top level master user profiles directory in Windows and

___give Everyone full read/write/modify control over the directory.

On each Dragon Medical Client workstation:

If workstations will access the profiles over a mapped network drive,

___map a drive to the master user profiles location.

If workstations will access the profiles through a UNC path,

___ensure the workstations have access to that path.

Refer to Choosing master user profiles location for a site on page 88and Setting up machine to host master user

profiles on page 90.

In NMC ConsoleMaster User Profiles Directory Settings dialog for each site:

Set Location to path each workstation later uses to access the master user profiles.

Set NMC UNC Path to path the NMS Server later uses to find the master user profiles.

Refer to Setting up machine to host master user profiles on page 90.
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Checklists —Setting up web server to
host master user profiles

Be sure that the web server machine is a Windows server or workstation with .NET

___Framework 3.5 SP1 installed and that the machine is in the same Windows domain

___as your DME servers.

Install the web server or secure web server.

Refer toInstalling software required to store master user profiles on web server on page 93.

Create top level master user profile directory on the web server.

Share the top level master user profiles directory in Windows and

___give Everyone full read/write/modify control over the directory.

On each Dragon Medical Client workstation:

If workstations will access the profiles through an https

___connection, install the required certificate on each workstation.

If master user profiles are on an http web server, open port 80.

If master user profiles are on an https web server, open port 443.

Refer to: Choosing master user profiles location for a site on page 1 and Setting up machine to host master

user profiles on page 90.

In NMC ConsoleMaster User Profiles Directory Settings dialog for each site:

Set Location to path each workstation later uses to access the master user profiles.

Set NMC UNC Path to path the NMS Server later uses to find the master user profiles.

Refer to Setting up machine to host master user profiles on page 90.

In NMC Console HTTP Settings or SSL Settings dialog for each site:

Set HTTP Settings for an http web server.

Refer to Setting HTTP connection settings for web server on page 106

Set SSL Settings for an https web server.

Refer to Setting SSL connection settings for secure web server on page 108
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Checklists — Upgrading roaming
users

To upgrade each directory of roaming users from Version 8.x or 9.x of Dragon Medical, be sure to

take all steps below in the order presented, starting with Before you upgrade, proceeding to Upgrad-

ing, and then to Associating user accounts with newly upgraded master user profiles. (You do not have to

upgrade roaming users from Version 10 or later of Dragon Medical.)

Be sure that all user profiles for a single site are in their own subdirectory of the

___master user profiles directory.

Schedule upgrade process during hours when dictation is not occurring.

Before you upgrade

Back up your Version 8.x or 9.x user profiles.

Install Dragon Medical SDK Client on the machine where you are upgrading the profiles.

Create lists of the different source directories of roaming user profiles you are upgrading.

Copy profiles from a single directory to their own folder on the upgrade machine.

On the upgrade machine, create a directory for the newly upgraded profiles to be stored in.

In NMC Console, create user accounts for all providers whose profiles you are upgrading.

Be sure that providers whose profiles you are upgrading are not dictating with Dragon Medical.

Refer to Creating user accounts for healthcare providers on page 117 and

Before upgrading Dragon roaming user profiles on page 119

Upgrading
For each directory of roaming users being upgraded to DME master user profiles:

On the upgrade machine, start the upgrade.exe utility.

In the User Upgrade Wizard, add the existing user profiles.

Execute the upgrade and choose the directory to store the newly upgraded profiles.

(Optional) In Advanced Options dialog, modify user information, such as the vocabulary.

Start the actual upgrade process by clicking Begin and click Finish when it completes.

Copy the new master user profiles to the master user profiles host on the DME network.

Refer to Before upgrading Dragon roaming user profiles on page 119
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Associating user accounts with newly upgraded
master user profiles
Note: Be sure you have already upgraded the profiles or you will not see them in the Existing

Profiles list.

In NMC Console, open the User Profile Association tool.

Select a user account from the list of User Accounts.

Select an upgraded profile for the user account from the list of Existing Profiles.

Click the Associate button.

Repeat the process for each user profile.

Refer to Associating new user accounts with upgraded user profiles on page 134.

Checklists — Converting local users
Schedule the conversion process during hours when dictation is not occurring.

Before you convert

Back up your Version 10 local user profiles.

Be sure that providers whose profiles you are upgrading are not dictating with Dragon Medical.

(If applicable) Combine multiple Dragon Medical
10.1 profiles for a single provider, keeping only one

Export custom words from extra profiles.

Export custom commands from extra profiles.

Export vocabularies from extra profiles.

Import the exported custom commands into profile you are retaining.

Import the exported vocabularies into profile you are retaining.

Import the exported words into profile you are retaining.

Exporting local user profiles

Create temporary location for local user profiles that exist.
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Create temporary location for roaming user profiles you will create as part of conversion.

In Dragon Medical Version 10, export local user profiles to the roaming user profiles

___location you created.

Enabling roaming feature on workstation

In Dragon Medical Version 10, enable the Roaming feature in Administrative settings.

Save the local users to the roaming user location you created.

Associating user accounts with newly converted
master user profiles
Note: Be sure you have already converted the profiles or you will not see them in the Existing

Profiles list.

In NMC Console, create a user account for each provider.

In NMC Console, open the User Profile Association tool.

Select a user account from the list of User Accounts.

Select an upgraded profile for the user account from the list of Existing Profiles.

Click the Associate button.

Repeat the process for each user profile.

Refer to Associating new user accounts with upgraded user profiles on page 134.
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Migrating roaming users to DME

In NMC Console, create user accounts for all providers whose profiles you are converting.

Copy the temporary roaming users you just created to a subdirectory of the master user

___profiles directory on the DME network.

In NMC Console, associate new user accounts with the newly converted user profiles.

On the workstation install the Version 10.1 Dragon Medical Client.

Log in using the new user account login and password.

Refer to Converting local user profiles to DME master user profiles on page 127.

Checklists — Installing Dragon
Medical Clients

There are several approaches to installing Dragon Medical Client and this checklist includes first pre-

requisite steps, then steps for each type of installation.

Before removing earlier version of Dragon Medical

Be sure you have converted any local user profiles from an earlier version of Dragon Medical

___to roaming user profiles before you remove the already existing installation of

___Dragon Medical. For instructions on how to convert the users, refer to

___Converting local user profiles to DME master user profiles on page 127.

Before beginning any client installation to a
workstation

Be sure workstations meet the requirements for installing Dragon Medical Client.

Be sure that the account that each Dragon Medical Client workstation runs under has full

___read/write/modify access to the master user profiles directory.

Be sure the Nuance certificates are installed on the client workstations.

Be sure you have the Dragon Medical Client serial number on hand.
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Downloading Dragon Medical Client MSI installer
through NMC Console

On the client workstation, log in as a Windows administrator.

Log in to the NMC Console.

Set location of the client MSI installer file on the NMS Server in the System Settings.

Download the MSI installer for the Dragon Medical Client from the NMC Console.

Log in to the client using a DME user account and enter the name of the NMS Server.

Refer to Downloading Dragon Medical Client MSI installer through NMC Console on page 142 and Ensuring

Dragon Medical Clients can find Nuance Management Server on page 149.

Installing Dragon client manually

Insert the Dragon Medical Enterprise Network Edition Client Software DVD into the DVD

___reader of the workstation.

Browse the DVD and double click the setup.exe file.

Follow the wizard instructions.

Log in to the client using a DME user account and enter the name of the NMS Server.

Refer to Installing Dragon client manually outside of NMC Console on page 145 and Ensuring Dragon Medical

Clients can find Nuance Management Server on page 149.

Pushing Dragon MSI installation to multiple
workstations: administrative installation

Copy and modify the admininstall.bat file provided on the

___Dragon Medical Enterprise Network Edition Client Software DVD.

Use any of the options or variables in the tables provided:

General options for installing Dragon

MSI options for installing Dragon features/advanced optionsCarrying out administrative instal-

lation of Dragon with .bat file on page 154

Refer to Carrying out administrative installation of Dragon with .bat file on page 154.
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Pushing Dragon MSI installation to multiple
workstations: using SCCM

Create MSI installer to use with SCCM to install Dragon Medical Client on several

___workstations.

Refer to Pushing Dragon MSI installation to multiple workstations on page 151.

Pushing Dragon MSI installation to multiple
workstations: creating custom installer for Active
Directory

Create the custom installer for Dragon Medical Client following the instructions provided.

Refer to Creating custom installer for installing client in Active Directory on page 161

Installing multiple clients with same default
options using MSI

Install Dragon Medical SDK Client on a client workstation where you will set the options.

Open a command window and run: natspeak /SetDefaultOptions

Set the Dragon Medical Client options under the tabs in the Options dialog box.

Retrieve the nsdefaults.ini file from the workstation where you set the options and

___copy it to a location accessible to all workstations you are installing.

Install Visual C++ Runtime for Dragon.

Create an MSI command line where you pass nsdefaults.ini file as value of DEFAULTSINI option.

Be sure to include the NAS_ADDRESS option in your MSI command line.

Refer to Installing multiple clients with same default options using MSI on page 168.
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Management Server (NMS

Server) and its components

To install the NMS Server and its components for the Dragon Medical Enterprise network, you carry

out the procedures in these sections:

Before installing Nuance Management Server and Console 26

Installing prerequisite software for NMS Server 28

Installing SQL Server 2008 32

Verifying necessary port is open 39

Installing Nuance Management Server and Console 40

Ensuring DME server anti-virus recommendations are met 48

Configuring network traffic switch to ping NMS Servers for load balancing 49

Verifying all necessary ports are open 49
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Before installing Nuance Management
Server and Console

Before you actually install the Nuance Management Server and Console, you should gather the infor-

mation indicated below and make modification to your machine's security policy.

Creating account to run all services
Note:

Before you carry out this procedure, be sure you have a Windows administrator account for run-

ning the server under, the same one you are running the Profile Optimizer Server under (named some-

thing like NMSapps) that meets the following requirements:

n Is in the organization's domain or, for a single server configuration, the workgroup.

n Never expires.

n Has a password that never expires (does not have to be changed at regular intervals).

n Has rights to install software and Windows services on the server.

n Has rights to create and start a Windows service on the server.

n Has full read/write access rights to all servers within the same network.

n Has full read/write access to the database server (if it is on a separate server).

n Has full read/write/modify permissions to access the directory housing the master user profiles.

During the installation, the wizard prompts you to enter the name of this user account and the

password to it.

Important: You should install all of the services of the product using this same account.

If you are creating the account for someone else to log in and install the software, the account

only need to be able to run NMS services and does not require Log into workstation rights.

Removing Security Obstacle
Security Measure—The NMS Server software is code signed by Nuance to allow Nuance Cus-

tomer Support access to the console computer's resources. However, to ensure Nuance has

access, if your hospital or medical facility's network requires a security policy on the computer

where you install the console, you should set up that security policy to allow any code signed by

Nuance to run on the machine with full trust credentials. If you are not an Information

 Technology professional, you should confer with your IT Department and have a professional

modify the security policy of the computer you are installing on.
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Gathering Information You Need
Before you begin, you need to have the following information:

Name or IP Address of NMS Server Machine—You need the name or address of the machine

where you intend to install the Nuance Administration Server (NMS). If your network uses dynamic

addresses, you should use the computer name to identify it, just in case the dynamic address

changes in the future.

To retrieve the name of the machine:

1. Click Start and move the cursor to highlight (but do not click) theMy Computer option; right

click onMy Computer and select Properties at the bottom of the drop-down menu. Or find

theMy Computer icon on your desktop, right click on it, and select Properties.

2. Click the Computer Name tab and look for the name to the right of Full computer name:.

The full computer name must include the Domain name (just below the computer name).

To retrieve the address of the machine:

1. Click Start and select Run...

2. When the Run window opens, type cmd in the Open text box and click OK.

3. When the Windows\system32\cmd.exe window opens, type ipconfig on the command line.

Among the information you should see in the window is the IP Address, made up of four

numbers with periods between them, such as 10.10.10.10. Copy down that number and keep it

for later.

Name or Address of Database Machine—You need the name or address for the server

machine where you either have installed or plan to install the NMS SQL Database. If your network

uses dynamic addresses, you should use the computer name to identify it, just in case the dynamic

address changes in the future.

To retrieve the name of the machine:

1. Click Start and move the cursor to highlight (but do not click) theMy Computer option; right

click onMy Computer and select Properties at the bottom of the drop-down menu. Or find

theMy Computer icon on your desktop, right click on it, and select Properties.

2. Click the Computer Name tab and look for the name to the right of Full computer name:.

The full computer name must include the Domain name (just below the computer name).

To retrieve the address of the machine:

1. Click Start and select Run...

2. When the Run window opens, type cmd in the Open text box and click OK.

3. When the Windows\system32\cmd.exe window opens, type ipconfig on the command line.

Among the information you should see in the window is the IP Address, made up of four

numbers with periods between them, such as 10.10.10.10. Copy down that number and keep it

for later.
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Installing prerequisite software
for NMS Server

Before you install the Nuance Management Server (NMS), you must install Windows Server and other

prerequisite software delineated below on the same machine:

n Windows Server 2008 or 2003 SP2, if the server software is not already installed.

n Any Windows service packs and updates available.

n Other prerequisite software:

l .NET Framework 3.5 SP1. This software is readily available on the web at the link pro-

vided.

l Internet Information Services (IIS). Version 6.0 requires that you have your Windows

DVD.

l PowerShell feature.

Although you do not have to install it on the same machine as the NMS Server, you should also

install the SQL Server 2008 database software before you install the NMS Server. For details, refer

to Installing SQL Server 2008 on page 32.

Installing Windows Server and .NET Framework
Follow these steps:

1. If you have not already done so, install Windows Server 2003 SP2 or 2008 (if it is not already

installed on the server machine).

2. After you install the server software, you should download any Windows updates to be sure you

have all updates available. Then, once you have all updates available, turn off automatic updates.

3. Install .NET Framework 3.5 SP1. You can download it from the web. Allow approximately

1 hour to install it. Retrieve the setup.exe file from this link and save it on your local disk:

http://www.microsoft.com/downloads/details.aspx?FamilyId=333325FD-AE52-4E35-B531-

508D977D32A6&displaylang=en

4. Once you have saved the setup.exe file, double click on the file to initiate the .NET Frame-

work installation.

5. When the .NET Framework installation is complete and Microsoft displays a dialog box that sug-

gests you retrieve any updates available for the program, click on the Windows Update link

and follow the on-screen instructions to install them.
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Installing Internet Information Services (IIS)
in Windows Server 2008
Note:

Instructions for installing Microsoft products are not guaranteed to be stable. For the latest infor-

mation, consult Microsoft. For more complete instructions on installing IIS Versin 7.0, visit

http://technet.microsoft.com/en-us/library/cc771209(WS.10).aspx.

To install IIS and any automatic updates in Windows Server 2008:

1. Go to your server desktop and click Start > Programs > Administrative Tools , then click

on Server Manager.

2. To see if it is installed, under Server Manager, expand Roles and look for IIS in the list. If

you do not see IIS, you need to install it.

29

http://technet.microsoft.com/en-us/library/cc771209(WS.10).aspx
http://technet.microsoft.com/en-us/library/cc771209(WS.10).aspx


Dragon Medical Enterprise (DME) Network Edition Installation Guide

3. Click on Add Roles and when the Add Roles Wizard opens, click Next.

4. Check the Web Server (IIS) check box in the Roles list.

5. When the Add features required for Web Server (IIS), click the Add Required Features

button.

6. When the installation wizard displays again, click Next to proceed to the Web Server (IIS)

page of the wizard.

7. Click Next to proceed to the Select Role Services page of the wizard and accept the services

selected by default (shown in the next illustration).
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7. Click Next to proceed to the Confirm Installation Selections page and verify your selections

underWeb Server (IIS).

8. Click Install. The Installation Progress page displays during installation.

9. When the Installation Results page appears, it should say Installation succeeded.

10. Click Close to exit the wizard.

11. Return to the Server Manager and click Roles in the Server Manager explorer. Under Role

Services verify that the list of IIS features that you installed is complete.

Installing PowerShell in Windows Server 2008
Before installing SQL Server 2008 on Windows Server 2008, install the PowerShell feature:

1. Click Start > Administrative Tools > Server Manager and then expand Add Feature.

2. If you do not see PowerShell in the list of installed features, click Add Features.

3. When the Select Features page of the Add Features Wizard appears, check the Windows

PowerShell feature in the list and click Next.
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4. Click the Install button and wait for the installation to complete. You might need to restart the

server after installing PowerShell.

5. Click the Close button to close the wizard.

When you have finished installing this required software, you are ready to install first SQL Server

(if it is not already installed), then the NMS Server.

Installing SQL Server 2008
Before you install the Nuance Management Server (NMS) or the Profile Optimizer Server, even if you do

not plan to install the database on the same machine as either server, you must install the database

server first. You usually install both NMS and Profile Optimizer databases on the same machine, as

shown in the Dragon Medical Enterprise Network Edition Planning and Deployment Guide.

For DME, you must install SQL Server 2008 on a Windows Server 2008 system where you have

installed the PowerShell feature in IIS.

Before you begin database software installation
Before you begin installing the database software, have the following information on hand:

n Machine name or IP address of the database's physical server.

n Windows user account name and password you want the database server to run under.

Caution:

Nuance recommends that you run all server services of DME Network Edition and even all

database services under the same Windows user account.

Installing SQL Server
To install SQL Server 2008 from the Nuance Management Server MS SQL 2008 DVD provided in

the DME Network Edition software package you received from Nuance:

1. Log on to Windows as an Administrator or as a domain user who has local administrative rights.

If you do not have that type of Windows account, create one first.

2. Using Windows Explorer, find and note which of the non-operating system hard drives has the

most unused space on it.

3. Insert the Nuance Management Server MS SQL 2008 DVD into the slot on your physical server.

4. If the install installation does not start automatically, find the setup.exe file on the DVD and

double click on it to start the installation.

5. When the SQL Server Installation Center dialog box appears, select New SQL Server

stand-alone installation or add features to an existing installation option.
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6. When the Setup Support Rulesdialog box displays, click OK.

7. When the Product Key page of the wizard displays, enter the product key you find on the

DVD case. Double check the ID and then click Next.

8. When the License Terms page of the wizard appears, check the box next to I accept the

license terms and click Next.

9. When the Setup Support Files page of the wizard appears, click Install.

10. If you are asked to create a local user with Administrative privileges and you do not have such

an account, create one now and click Next to continue.
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11. When the Feature Selection page of the wizard displays, you should select the features shown

in the next illustration and click Next to continue. Analysis Services and Reporting Services

are not required by eitherNMS Server or Profile Optimizer Server; however, if any problems occur

with your installation or later with your databases, these services can help Nuance technical sup-

port troubleshoot the problem, so you might choose to install them as a proactive measure.

12. When the Instance Configuration page of the wizard displays, leave the Default instance

option selected and click Next.

13. When the Disk Space Requirements page of the wizard displays, verify that you have

adequate storage space on the server and click Next.

14. When the Server Configuration page of the wizard displays, click the Use the same account

for all SQL Server services button.
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15. When the Use the same account for all SQL Server 2008 services popup appears, enter the

username and password of the Windows user account that the SQL Server services should all

run under and click OK. You should use the same account that the DME services will run

under. That account can be in a workgroup instead of a domain and Nuance recommends that

you use an account in a workgroup if you are planning to install all DME servers along with the

database on a single machine.

Enter the name of the domain where the server resides followed by a backslash and then the

user name for the account. Enter the password other servers and clients on theDragon Medical

Enterprise network will use to access the database.
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16. When you return to the wizard, click Next.

17. When the Database Engine Configuration page of the wizard appears, you choose the type

of authentication you want to use when allowing access to the SQL Server database.

l Under Authentication Mode, Nuance recommends that you select Windows Authen-

tication Mode (see illustration above). You would selectMixed Mode only if you plan to

later attach to the database using an Active Directory account or an SQL Server account.

Keep in mind that SQL Server accounts have full access to the database.
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l If you selectMixed Mode, then under Built-in SQL Server system administrator

account, enter the password in Enter password and type the password a second time in

Confirm password.

l Regardless of the type of authentication you choose, under Specify SQL Server admin-

istrators, click Add... and add the account you are installing under to make that account an

SQL Server administrator will full access to the database, as you will need that access later

in the installation process.

18. Still on the Database Services Configuration page of the wizard, to add the user account for

the person is carrying out the installation to the list of users who can administer the database,

click Add Current User... The user's name then appears in the list under Specify SQL Server

administrators.

19. Click Add and add the account you created for all services to run under, to ensure it not only

has access to the database, but can also administer the database.

20. Finally, click Add again and add at least one other user to the list to ensure that if either of the

first two accounts is accidentally locked out of the database, you have one more account with

the ability to administer the database.

When you have added all these users to the database administrator list, click Next.

21. When the Analysis Services Configuration page of the wizard displays, under the Account

Provisioning tab, click the Add Current User button to add the installer's user account to the

list of users who can have access to the Analysis Services.

22. Click the Add button and add the NMSapps user account to give that account access to the

Analysis Services.

23. Click the Add button again and add the database administrator account to give that account

access to the Analysis Services; then click Next.

24. When the Reporting Services Configuration page appears, select Install the native mode

default configuration and click Next.
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25. Skip the Error and Usage Reporting page and click Next

26. Click Next until you reach the Ready to Install page of the wizard.

27. Click Install and wait for the installation to complete. If you have not installed PowerShell and

receive an error about PowerShell, click OK to continue.

28. If you experienced any failures while running the wizard, the Complete with failures page

appears.
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If you receive this page, click on the link near the top of the page under Summary log file has

been saved to the following location and save the log in a location where you can retrieve it.

If you later have any network issues, you can provide this log file to the Nuance support team.

29. After the installation is complete, to verify that all SQL Server database services are running

before you begin to install the DME servers, select Start > Administrative Tools > Services

and check the Services window.

Verifying necessary port is open
Be sure that port 1433 is open on the database server that houses the NMS SQL Database.

39



Dragon Medical Enterprise (DME) Network Edition Installation Guide

Installing Nuance Management
Server and Console

This procedure covers installing all components of the Nuance Management Server (NMS), including

the server, the console, and the database.

Creating account to run all services
Note:

Before you carry out this procedure, be sure you have created a Windows administrator account to

run this server and all other servers under (name it something like NMSapps). That server should

meet the following requirements:

n Is in the organization's domain.

n Never expires.

n Has a password that never expires (does not have to be changed at regular intervals).

n Has rights to install software and Windows services on the server.

n Has rights to create and start a Windows service on the server.

n Has full read/write access rights to the Profile Optimizer Server and all Profile Optimizer Speech

Nodes server(s) within the same network.

n Has full read/write/modify permissions to access the directory housing the master user profiles.

During the installation, the wizard prompts you to enter the name or this user account and the

password to it.

Be sure you have the organization identifier Nuance assigned you, delivered to you via email, in a

readily accessible file on a stick or on the Windows Server itself.

Also be sure you have the name or IP address of the machine where the Profile Optimizer is either

installed or to be later installed, because you supply that information to the NMS Server during the

installation so that it later knows how to communicate with the Profile Optimizer.
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Installing the NMS—Server, Console, and Database
You are now ready to install all of the components of Nuance Management Console. You install them

on the same machine using a single installation wizard. (After the installation is complete, you

then use the console to configure the server.)

Caution:

If you do not want to store the NMS Server's data files in SQL Server's default location, you can

let the installer create the database, its transaction log, and its dump device in the default location,

then move the database and its files to the location you would prefer.

FOR ADVANCED INSTALLERS ONLY:

If you are installing the database in any location other than the SQL default, you can create the

NuanceMC.mdf database, the NuanceMC_log.LDF transaction log, and the Nuan-

ceMCDump.bak dump device in SQL Server before installing the NMS Server; otherwise, the

NMS Server installation ends up placing these files in the SQL default location.

1. The NMC Console software is code signed by Nuance to allow Nuance Support access to the

client computer's resources. However, to ensure Nuance has access, if your hospital or medical

facility's network requires a security policy on the computer where you install the client, you

should set up that security policy to allow any code signed by Nuance to run on the machine

with full trust credentials.

2. Before you begin the installation, you might want to turn off the Windows Server 2008 Fire-

wall. If you prefer not to turn it off, you later need to open Port 8731 (the step is included at

the end of this process) to ensure communication between the NMS Server and NMC Console.

3. This step applies whether you are installing the NMS Server on the same machine as the SQL

Server or on a separate/possibly remote machine. If you are planning to store data files in the

default location that SQL uses, skip to step 4. If you instead plan to store data files in another

location, you can later move the database and its associated files after you let the installer create

them for you.

(Alternatively, you can create the NuanceMC.mdf database, the NuanceMC_log.LDF trans-

action log, and the NuanceMCDump.bak device inside SQL Server first and specify where

you want these files to reside, but Nuance recommends that you be an advanced user to create

your own database.)

4. Insert the Nuance Management Server Software and Documentation DVD in the DVD reader of your

server. Browse the DVD until you find the Nuance Management Server and Console

Installation.exe file and double click it to launch the installation process.

5. Initially, you wait for a moment while the InstallShield wizard uncompresses the software; then

the DME Nuance Managmenet Server & Console Installation wizard displays to walk you

through the installation process.
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6. Click Next to see the License Agreement page and accept the terms of the license agreement;

then click Next to proceed to the Customer Information page of the wizard.

7. In the Customer Information page of the wizard, enter your name (or the name of an appro-

priate contact person) and your organization name in the User Name and Company Name

text boxes and click Next to proceed to the Choose Destination Location dialog box.
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8. The Choose Destination Location page of the wizard presents the location where it installs

the NMS Server by default. If you want to change where the wizard installs the server, click

Browse... and browse to a location you prefer.

9. Click Next to proceed to the Database Server page.

10. In the Database server that you are installing to text box, enter the machine name or IP

 address of the physical server where you have installed the SQL Database Server software.

The wizard automatically creates the database and its backup directory in default locations on

that server.
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Under Connect using, you see from two ways for the server to access the database—using a

Windows login and password to authorize access, as indicated by Windows authentication or

an SQL Server login and password, as indicated by SQL Server authentication.

You should choose the same type of authentication for access to the database that you chose

when you installed the SQL Server.

Nuance recommendsWindows authentication. If you choose this type of authentication, the

Login ID and Password text boxes become unavailable, as they are not required.

If you choose SQL Server authentication using the Login ID and password below, you

then enter the database system administrator login name and password that you set up in SQL

Server earlier into the Login ID and Password text boxes provided.

Click Next to continue.
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11. In the Organization ID page of the wizard, enter the unique ID that Nuance has assigned you.

You should receive this ID on a slip of paper inserted with your DME software package. Care-

fully enter the ID into the ID text box here. You do not have to write it down or keep track of

it on paper after you enter it here, as you will later be able to find the ID any time you need it

through the NMC Console. Click Next to continue.
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12. In the Service logon page, the wizard asks you for the user account that the NMS Server service

is going to run under. You should enter the Windows user name and password of the account

you created at the start of this procedure for all services to run under (such as NMSapps).

If the wizard determines that the user account you enter is not an administrator account or does

not have rights to start the NMS Service or is inadequate in any other way, the wizard fails to let

you proceed and stays on this page until you enter an acceptable account or click Cancel. If

this situation arises, you should enter the local administrator or local system account and pass-

word in this page. If you need to enter such an alternative account here, you later need to

change the account that the service is running under as described in Changing the account running

NMS Server under Changing the account running NMS Server on page 80.

13. Click Next to continue.

14. In the Profile Optimizer Server page of the wizard, you enter the machine name or IP address

of the physical server where the Profile Optimizer Server is (or will be) installed. The NMS Server

needs to know this information to communicate with and pass data between itself and the Profile

 Optimizer. Often you are installing the Profile Optimizer Server on the same machine as the

DME server databases, as shown above. Click Next to continue.
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15. In the Ready to Install the Program page of the wizard, you can click Back to return to any

of the previous dialogs or, if you are ready, click the Install button to launch the actual instal-

lation.

16. When the installation is complete, click Finish to close the wizard.
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17. If you installed the NMS Server and NMC Console with the Windows Server 2008 Firewall

turned on during the installation, you must now open Port 8731 so that the NMC Console can

communicate with the NMS Server.

18. As part of the process of installing the NMS Server, the installer:

n Creates the actual NMS SQL Database, a transaction log file, and a dump device on the

SQL Server that you installed earlier. When you look in SQL Server, you see:

l Database, namedNuanceMC.mdf

l Transaction log namedNuanceMC_log.LDF

l Dump device namedNuanceMCDump.bak.

n Installs the service that the NMS Server uses, the Nuance Management Service.

After the installation completes, the NMS Server automatically starts.

You are now ready to install the Profile Optimizer Server.

Ensuring DME server anti-virus
recommendations are met

Nuance recommends anti-virus software on all Dragon Medical Enterprise Network Edition servers and

clients to protect the system from potential downtime due to viruses. However, be aware of the

recommended restrictions.

After you have installed the servers, be sure to exclude from the anti-virus scan any files found in

the folders indicated below or with the extensions listed below.

On NMS Servers, Profile Optimizer Server, SQL Database Server:

n Nuance folder and all subfolders

n Files with these extensions:

DAT, DRA, ENH, INI, LCK, LOG, NWV, SIG, TXT, USR, VER, VOC, WAV
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Configuring network traffic switch to
ping NMS Servers for load balancing

If you have a large network with multiple NMS Servers, you can include a network traffic switch in

your network to balance the load on the NMS Servers. The network traffic switch can be an F5 or

similar switch.

To configure the network traffic switch to send a message to the NMS Server to see if the server is

operational, you would have the network traffic switch send the following message in the URL

 line of the browser:

http://<NMS-Server-Name>:8051/Nuance.NMS.Services/

__NMSServiceStatus/Rest/Status

The NMS Server delivers the following XML-formatted response to the network traffic switch:

<ServiceStatusResponse xmlns=

"http://schemas.datacontract.org/2004/07/Nuance.NAS.Connector.

DictationTranscription" xmlns:i="http://www.w3.org/2001/

XMLSchema-instance">

__<Status>Running</Status>

__<ServerDateTimeUTC>2010-12-13T20:50:13.0969590Z

____</ServerDateTimeUTC>

__<InterfaceType>basicHttpTransport</InterfaceType>

</ServiceStatusResponse>

If the NMS Server is down, the switch receives an error. If the network traffic switch makes this

call and the NMS Server sends anything other than the expected response, the switch can tag that

server as down and reroute the traffic accordingly.

Verifying all necessary ports are open
Be sure that all of the following ports are open on the NMS Server:

n 8730

n 8051

n 433 and 80

n 1433 on both the NMS Server and the database server where the NMS SQL Database resides

n 808 for communication with the Profile Optimizer
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To install the Profile Optimizer components of the Dragon Medical Enterprise Network, you carry out

the procedures in these sections:

Before Installing Profile Optimizer components of DME 52

Installing prerequisite softwarefor Profile Optimizer Server 53

Installing additional prerequisite software for Speech Nodes 55

Installing Profile Optimizer Server with or without Speech Nodes on same machine 57

Installing Profile Optimizer Speech Nodes on independent machine(s) or virtual

machine(s) 65

Ensuring DME server anti-virus recommendations are met 70

Verifying all necessary ports are open 71
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Before Installing Profile Optimizer
components of DME

Before you actually install the Profile Optimizer, you should gather the information and install some

additional prerequisite software, as indicated in this section. This section details the information

you need about configuration settings you will set during the installation process.

Creating account to run all services
Note:

Before you carry out this procedure, be sure you have a Windows administrator account to run all

servers under. It should be the same one you are running the NMS Server under (named something

like NMSapps). For details about the requirements for this account, refer to Before installing

Nuance Management Server and Console on page 26.

During the installation, the wizard prompts you to enter the name of this user account and the

password to it. You must set up this account with Log on as Service rights so that it can start Pro-

file Optimizer and Speech Node services when the installation is complete.

For more information on how to set rights to start a service, refer to Installing Profile Optimizer

Speech Nodes on independent machine(s) or virtual machine(s) on page 65.

Gathering information you need
Before you begin, you need to have the following information:

n Name or Address of Installation Machine You need the name or address of the machine

where you intend to install the Profile Optimizer Server. If your network uses dynamic addresses,

you should use the computer name to identify it, just in case the dynamic address changes in

the future.

n Location of Master User Profiles folder If you are planning to put the user profiles directory

on the same machine with the Profile Optimizer installation, you should know that in advance.

n Name of Machine where Profile Optimizer Database Server resides and name of folder

for Database Files Profile Optimizer requires access to the Profile Optimizer Database (possibly

on the same machine) through its physical server's name. You will need to provide the database

server name during the installation.

n Create a folder to contain the database files for the Profile Optimizer Database and create it on the

machine where the Profile Optimizer Database is installed. Be sure you know where this folder is

located, as you will need to provide the full path to it during the installation. You create this

folder on a disk of the machine, not inside SQL Server's Object Explorer
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Installing software to support Profile
Optimizer Speech Nodes installation/operation
You install two extra packages on machines where you are planning to install Profile Optimizer

Speech Nodes:

Windows Installer 3.1 If you are installing a Speech Node on a machine with any supported oper-

ating system other than Windows Server 2008, the installer requires that the machine have Win-

dows Installer 3.1 or greater on it. (Windows Server 2008 automatically installs a later version of

Windows Installer.) For information on operating systems that support Speech Nodes refer to Dragon

Medical Enterprise Network Edition Planning and Deployment Guide.

Dragon Medical SDK Client Version 10.1 You must install Dragon Medical SDK Client Version

10.1 software on workstations where you plan to install Speech Nodes. This software is included on

the Nuance Management Server Software and Documentation DVD.

Installing prerequisite software
for Profile Optimizer Server

Before you install the Profile Optimizer components, you must install the Windows Server and

other prerequisite software. Some of this software is required for both the NMS Server and the Pro-

file Optimizer Server.

You will probably install the databases forNMS Server and Profile Optimizer Servers on the same

physical server, then install the Profile Optimizer on the same machine as the database.

Before you install the Profile Optimizer Server, you must install all of the following (if you have not

already installed them):

n Windows Server 2008 or 2003 SP2, if the server software is not already installed.

n SQL Server 2008, using the Nuance Management Server MS SQL 2008 DVD included in the DME

Network Edition software package (does not have to be on the same physical server as the Profile

Optimizer).

n Any Windows updates available.

n .NET Framework 3.5 SP1. This software is readily available on the web at the link provided.

You need to install additional prerequisite software for Speech Nodes. For more information and

instructions on additional packages you must install for Speech Nodes, refer to the next major sec-

tion, Installing additional prerequisite software for Speech Nodes on page 55.
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Installing Windows Server and .NET Framework
Follow these steps:

1. If you have not already done so, install Windows Server 2008 or 2003 SP2. Follow the instruc-

tions in Installing SQL Server 2008 on page 32.

2. After you install the server software, you should download any Windows updates to be sure you

have all updates available. Then, once you have all updates available, turn off automatic updates.

3. If you have not already done so, install SQL Server 2008 following the instructions provided in

this manual. You must have the database software installed before you install Profile Optimizer.

4. Install .NET Framework 3.5 SP1. You can download it from the web.

Allow approximately 1 hour to install it. Retrieve the setup.exe file from the link below and save

it on your local disk:

http://www.microsoft.com/downloads/details.aspx?FamilyId=333325FD-AE52-4E35-B531-

508D977D32A6&displaylang=en

5. Once you have saved the setup.exe file, double click on the file to initiate the .NET Frame-

work installation.

6. When the .NET Framework installation is complete and Microsoft displays a dialog box that sug-

gests you retrieve any updates available for the program, click on the Windows Update link

and follow the on-screen instructions to install them.

For information and instructions on additional packages you must install for Speech Nodes only,

refer to the next major section, Installing additional prerequisite software for Speech Nodes on page 55.

If you are installing only the Profile Optimizer Server right now, you can proceed to Installing Profile

Optimizer Server with or without Speech Nodes on same machine on page 57.
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Installing additional prerequisite
software for Speech Nodes

On machines where you are installing Profile Optimizer Speed Nodes, you must install all the same

software you installed for the Profile Optimizer Server, except that:

n You have the option of installing a Speech Node on a workstation rather than a server.

n You are required to install additional software packages—an installer and an SDK.

Operating Systems and related software for Speech Nodes

n You can install a Speech Node on any of the following Windows Operating Systems:

Windows XP SP3, Windows Vista, Windows 7, or Windows Server 2008. For more

information on operating systems that support Speech Nodes, refer to the Dragon Medical Enterprise

Network Edition Planning and Deployment Guide.

n Any Windows updates available.

n .NET Framework 3.5 SP1.

Additional software packages for Speech Nodes Only

Additional packages that you need to install on Speech Nodes only are:

n Windows Installer 3.1 or greater, only if you are installing the Speech Node on any operating

system other than Windows Server 2008.

n Dragon Medical SDK Client Edition 10.1, required for every Profile Optimizer Speech Node.

More information on each additional package is in the corresponding section below.

Installing Windows Installer 3.1 or Later (For
Speech Nodes on any operating system other than
Windows Server 2008)
Every machine where you use install a Profile Optimizer Speech Node, Windows Installer 3.1 or

greater must be on the machine.

Caution:

If you are installing on a Windows Server 2008 machine, you installed the Windows Installer

when you installed the operating system, so you can skip this section.

To install Windows Installer 3.1:

1. Proceed to the web site at:

http://www.microsoft.com/downloads/details.aspx?FamilyID=889482FC-5F56-

4A38-B838-DE776FD4138C&displaylang=en
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2. Scroll down the web page until you find a heading that says Files in This Download and a list

of files below it (see illustration):

3. Click the third Download button for the executable to download the file for the software.

4. When you are prompted to either save or run the file, click Run and follow the wizard instruc-

tions Microsoft provides.

Installing Dragon Medical SDK Client Edition
You can find the Dragon Medical SDK Client software on the Nuance Management Server Software and

Documentation DVD. You must install this software on every machine or virtual machine where

you plan to install a Profile Optimizer Speech Node. To install the software:

Note:

After you install the Dragon Medical SDK Client, you can use the Dragon Medical SDK Clientnat-

speak command to pre-configure default settings for multiple workstations. For details, refer to

Setting default Client options on command line before installing on page 168.

1. In the Dragon Medical SDK Client directory of the Nuance Management Server Software and Doc-

umentation DVD, find the Dragon SDK Client Edition10.msi file and double click it.

2. Click Next and, when choosing the type of installation, be sure to select Typical/

Complete.

3. Click Next until you reach the installation page of the wizard.

4. Click Install.

5. When the installation is complete, click Finish.

When you have finished installing this required software, you are ready to install the Profile

Optimizer Server and Speech Nodes.
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Installing Profile Optimizer Server
with or without Speech Nodes on
same machine

This section of the installation covers installing the Profile Optimizer Server with or without a Speech

Node on the same machine. If you have already installed the Profile Optimizer Server and want to

install one or more Speech Nodes on another machine, you should proceed to Installing Profile Opti-

mizer Speech Nodes on independent machine(s) or virtual machine(s) on page 65.

Caution:

When you are installing the Profile Optimizer Server, since you are also installing the Profile Optimizer

 Database, regardless of whether you install both the server and database on the same physical

server, you should:

n Be sure to install SQL Server on the machine where the database will reside before installing the

Profile Optimizer Server.

n After the database software is installed, go to a drive (such as C:) on the machine where you

have installed SQL Server and create a folder for the database files, such as ProfOpt_DB. Note

the full path to this folder is C:\ProfOpt_DB. You later enter this path during the installation,

so the Profile Optimizer Server knows where to find the files.

After you have installed all other prerequisite software and SQL Server, regardless of whether or

not you plan to install any Speech Nodes on the same machine, you install the Profile Optimizer Server

as follows:

1. Create a folder on the database server's hard drive to store the database files of the Profile Opti-

mizer. Make a note of the full path to this file, as you enter it later in this installation process.

2. Insert the Nuance Management Server Software and Documentation DVD in the DVD reader of your

server. Browse the DVD until you find the ProfileOptimizerServices.msi file and double

click on it to launch the installation. After you see the wizard start, click Next to proceed.
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3. When the Profile Optimizer Services page of the wizard appears, choose the parts of the prod-

uct you want to install on the particular machine. To intall both the Speech Node and the server,

you must install both at the same time by selecting both check boxes (as shown below), because

if you try to use the installer on the same machine after installing a single component, not select-

ing the check box for a component uninstalls that component. To install the Profile Optimizer

 Server alone on a machine, select only the Install Profile Optimizer Server check box, instead

of both check boxes.
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If you are trying to install the Speech Node along with the server but the Install Profile Opti-

mizer Speech Node check box is grayed out, it is probably because you do not have the

required prerequisites installed, including Windows Installer 3.1 or greater and the Dragon Med-

ical SDK Client. If this situation arises, click Cancel and go back to the instructions in Installing

additional prerequisite software for Speech Nodes on page 55 then return to the beginning of this sec-

tion and start over.

If you do want to install the Speech Node on the same machine as the server, you can install only

a single non-virtualized node, because you are allowed to install only one Profile Optimizer Speech

Node on the same machine with the server.

4. Click Next to proceed to the Service Account Configuration page of the wizard.

On this page, you enter the domain and user name of the account to run the services under.

Nuance recommends that you enter the account you created earlier to run all services under,

that it be the same account you are running the NMS Server under, and that you assign an appro-

priate name, such as NMSapps, to the account. After you enter the password, you need to

enter it again in Confirm Password.

If the domain, machine name, user account name, or password is not valid, the installer does

not let you proceed until the values you enter are valid.

You can also choose to run all Profile Optimizer services other than the Speech Node service under

the Local Service Account by checking the check box labeled Use Local Service Account.
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You might make this choice to have the non-Speech Node services inherit the security context of

the Windows service control manager, which requires that anyone attempting to access the serv-

ices enter credentials.

(If you are installing both the server and the Speech Nodes, the check box is labeled Use Local

Service Account for Non-Speech Node Services to clarify that you cannot run Speech Node

services under the Local Service Account.

Caution:

The account that the Profile Optimizer Server and Speech Nodes run under must have full rights to

access the master user profiles, including rights to modify files in the profiles directory.

5. After you click Next, the Profile Optimizer Folder Configuration page of the wizard

appears. Here you set the paths, shown in the next illustration, to the Profile Optimizer log files

and the task result files.

l Folder to store Profile Optimizer Services log files—Full path to the file that should

contain the logs that all Profile Optimizer processes create. You can enter your own custom

path or click Browse to find the location you want. The default location is

C:\Program Data\Nuance\Profile Optimizer Services\Logs.
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l Folder to store task result files—Full path to the output files that speech tasks create.

These files include Speech Node logs and Dragon logs that the NMS Server can retrieve (for

more information on logs, see the Nuance Management Server Administrator Guide. You can

enter your own custom path or click Browse to find the location you want. The default loca-

tion is C:\Program Data\Nuance\Profile Optimizer Services\Jobs\

6. When you have entered the information, click Next to proceed to the Server Configuration

page of the wizard. Here you enter information required for the Profile Optimizer Server to con-

nect to the NMS Server and the database server where the Profile Optimizer SQL Database resides

(usally the same physical server where the NMS SQL Database resides, but not always). Nuance

recommends that you use Windows Authentication to connect to the Profile Optimizer SQL

 Database.

l NMS Server Name Enter the machine name of the physical server where you installed the

NMS Server software. (You probably installed the NMS database on a separate machine.)

l SQL Server Name Enter the machine name of the physical server where you installed the

SQL Server database software.

l Use Windows Authentication check box. Check this box to use Windows Authentication.

To instead use SQL Server Authentication, you need to fill in the SQL system administrator

user name and password in the SQL User Name and SQL Password text boxes.
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7. When you have entered the account information, click Next to proceed to the Database Cre-

ation page of the wizard. Here, you see the name of the physical server that is the database

 server in the SQL Server Name text box.

Below the database server name, in Folder path of SQL Server database files on database

server, enter the full path to the folder on the SQL Server machine that you created at the

beginning of these instructions or during the SQL Server installation. The purpose of this file is

to store the database files that host the database. (The full path must start with the disk name;

for example, C:\ProfOpt_DB.)

Note:

You create the database files folder for the Profile Optimizer database on the main disk drive of your

machine, not inside the SQL Server Manager Object Explorer tree structure. If you are installing

the database on the local machine, the installer creates this folder for you.

8. Click Next to proceed to the Ready to install Profile Optimizer Services page, where you

click Install to launch the installation.
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9. When the installation is complete, you receive the final page of the wizard. Click Finish to exit

the wizard.

63



Dragon Medical Enterprise (DME) Network Edition Installation Guide

10. As a result of installing the Profile Optimizer Server, the installer:

n Creates the actual database in SQL Server.

n Install all services of the Profile Optimizer Server, including:

l Profile Optimizer Core Services

l Profile Optimizer NMS Integration

l Profile Optimizer Host Manager

n Installs the service of the Profile Optimizer Speech Node:

l Profile Optimizer Speech Node

You can now verify that the server installations were successful by proceeding to Starting servers

and logging in to NMC Console on page 73. The services should start automatically after you com-

plete the installation. However, even after the Profile Optimizer Server is running, it is not fully oper-

ational until you have installed at least one Speech Node.

Either before or after you verify the services are running, if you have not yet installed any Speech

Nodes, to install one or more nodes on machines other than the Profile Optimizer Server machine,

you should proceed to the next section, Installing Profile Optimizer Speech Nodes on independent

machine(s) or virtual machine(s) on page 65

64



Chapter 3: Installing Profile Optimizer components

Installing Profile Optimizer Speech
Nodes on independent machine(s) or
virtual machine(s)

Before you install any Speech Nodes, be sure to install the Profile Optimizer Server (see Installing Profile

Optimizer Server with or without Speech Nodes on same machine on page 57.

In large DME Network configurations, you usually install multiple Profile Optimizer Speech Nodes on

their own independent machines or on virtual machines. Once you have installed them on one or

more separate machines, Profile Optimizer Speech Nodes automatically find the Profile Optimizer Server

and add themselves to the network as resources for the Profile Optimizer. Because of this self-

attaching feature of Profile Optimizer Speech Nodes, you can add more nodes as your network require-

ments grow.

Installing Profile Optimizer Speech Nodes
To install Profile Optimizer Speech Nodes on their own machines or virtual machines:

1. Be sure that on the Speech Node machine you have all prerequisite software installed, including

the operating system and related packages, plus the installer and SDK required for Speech Nodes

only, as covered in Installing additional prerequisite software for Speech Nodes on page 55.

2. Insert the Nuance Management Server Software and Documentation DVD in your server's DVD

reader. Browse the DVD until you find the ProfileOptimizerServices.msi file and double

click on it to launch the installation.
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3. After you see the wizard start, click Next to proceed.

4. When the Custom Setup page of the wizard appears, select only Install Profile Optimizer

 Speech Node.

If you attempt to install a Profile Optimizer Speech Node on an operating system other than Win-

dows Server 2008 without first installing the prerequisite Windows Installer 3.1 and Dragon Med-

ical SDK Client software, the Install Profile Optimizer Speech Node check box is grayed out

so that you cannot select it. If this situation arises, click Cancel and go back to the instructions

in Installing additional prerequisite software for Speech Nodes on page 55Installing additional prerequisite

software for Speech Nodes on page 55 then return to the beginning of this section and start over.

5. Click Next to proceed to the Service Account Configuration page of the wizard.
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On this page you enter the user name and password of the account that this Speech Node service

will be running under. The account should be the same account that the NMS Server and the Pro-

file Optimizer Server are running under (unless you chose to have the Local Service Account run

the Profile Optimizer), and should have an appropriate name, such as NMSapps.

If you are running the Profile Optimizer Server under the Local Service Account, you need to run

all associated Speech Nodes under that account as well.

After you enter the password, you need to enter it again in Confirm Password.

If the domain or machine name or the user account name or password are not valid, the installer

does not let you proceed until the values you enter are valid.

6. Click Next to proceed to the Profile Optimizer Folder Configuration page. Here you enter

the full path to the folder that you want to store Profile Optimizer service log files that the Speech

 Node produces.
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In the Folder to store Profile Optimizer Services log files text box, you can enter your own

custom path or click Browse to find the location you want. The default location is operating

system dependent, so yours may not match the one shown here, which is on a Windows XP

SP3 machine.

For instance, the default location on a Windows 2008 Server would be:

C:\Program Data\Nuance\Profile Optimizer Services\Logs

And the default location on a Windows XP workstation is:

C:\Documents and Settings\All Users\Application Data\Nuance\Profile Optimizer Services\Logs

7. Click Next to proceed to the Speech Node Configuration page of the wizard. Here you enter

the name of the physical server where the Profile Optimizer Server for this Speech Node resides.
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In many cases, the Profile Optimizer Server resides on the same machine as the ProfileOptimizer

SQL Database, as is the case for the Walden organization shown throughout this chapter, where

the NMS Server is installed onWalden_NMS, and the Profile Optimizer and all databases are

installed on the Walden_DB machine (see above illustration).

8. Click Next to proceed to the Ready to install Profile Optimizer Services page of the wizard.

Here you click Install to launch the installation process and wait for it to complete.
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9. When the installation is complete and you receive the final page of the wizard, click Finish to

exit the wizard.

While installing a Profile Optimizer Speech Node, the process installs the Profile Optimizer Speech

Node service. This service should start automatically after you complete the installation.

You are now ready to verify that the Profile Optimizer Server and Speech Node services are running. Be

sure to follow the steps outlined in the next chapter, Starting servers and logging in to NMC Console on

page 73.

Ensuring DME server anti-virus
recommendations are met

Nuance recommends anti-virus software on all Dragon Medical Enterprise Network Edition servers and

clients to protect the system from potential downtime due to viruses. However, be aware of the

recommended restrictions.

After you have installed the servers, be sure to exclude from the anti-virus scan any files found in

the folders indicated below or with the extensions listed below.

70



Chapter 3: Installing Profile Optimizer components

On NMS Servers, Profile Optimizer Server, SQL Database Server:

n Nuance folder and all subfolders

n Files with these extensions:

DAT, DRA, ENH, INI, LCK, LOG, NWV, SIG, TXT, USR, VER, VOC, WAV

Verifying all necessary ports are open
Although the installer opens the ports for you, you should verify that all of the following ports are

open on the Profile Optimizer Server:

n 8000

n 8001

n 905
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Installing Nuance certificates
Although you have installed the NMS Server software, you cannot log in to the NMS Server

through the NMC Console until you install the Nuance Software Certificates.

Caution:

You must install these Nuance Software Certificates on every machine where you want to log in to the

NMC Console.

These certificates are in the Nuance Software Certificates.msi file provided on the Nuance Man-

agement Server Software and Documentation product DVD.

You must have Windows administrator privileges on the machine to install the certificates.

Installing Nuance Security Software Certificates
To install the Nuance Software Certificates:

1. If it is not already there, insert the Nuance Management Server Software and Documentation DVD into

your DVD reader.

2. Browse the DVD for the file namedNuance Software Certificates.msi.

3. Double click on the file and when you are prompted, click Save to download and save it or

Run to run it without downloading it. If you save it, then find the file where you saved it and

double click on it.
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4. The Nuance Software Certificates InstallShield Wizard appears.

5. Click Next to continue to the Custom Setup page.

6. On the Custom Setup page, choose to download the feature or and all of its subfeatures on the

local hard drive. Then click Next to continue.

7. On the Ready to Install the Program page, click the Install button and give the installer time

to install the certificates.
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8. When the installation is complete, you should see the InstallShield Wizard Completed page

and can click Finish to close the wizard.

You are now ready to run the NMC Console. For instructions, proceed to Logging in to the NMS

Server through the NMC Console on page 77.
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Logging in to the NMS Server through
the NMC Console

Before you can log in to the NMS Server using the NMC Console, you must be sure you have

installed the Nuance Software Certificates. If you have not installed them on the machine you

want to use the NMC Console on, install them before you log in. Refer to Installing Nuance certificates

on page 74.

Caution:

If the time and date setting on a workstation machine you are trying to log in through is more than

5 minutes different from the time setting on the NMS Server, you will not be able to log in

through the NMC Console on that workstation. If you have trouble logging in, synchronize the

clock settings on those machines.

Once you are sure the NMS Server is running, you should be able to log in to the NMC Console. To

verify you can log in:

1. Once the server is running, you use the IP address or name of the machine where the server

was installed to access the server and configure it.

2. Go to any workstation on the network and open a browser window.

3. In the URL line of the browser, enter http://<IP_address>/nmc/Client.xbap, entering your

server machine's IP address (but not the angle brackets). Then click the Go or similar button in

the browser. Or, if you know the server name, use its name instead of its IPaddress:

http://<servername>/nmc/Client.xbap

(The URL shown here is based on the location of the .xbap file if you installed the NMS Server

under the default directory.)

4. When the Nuance Management Console login box appears, enter admin as the user name

and password as the password, then click Log on.
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5. To change the standard login and password, refer to the Nuance Management Server Administrator

Guide.

6. The Home page appears. In this page, you see links to the various features of the NMS Server.

Note:

Be sure you change the standard login and password before you log out.

For how to the change the password and other information on configuring the Dragon Medical Enter-

prise network and the Nuance Management Server, refer to the Nuance Management Server Administrator

Guide (PDF) or the Nuance Management Console Help.
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Ensuring NMS Server can
communicate with Speech Node(s)

To ensure the NMS Server can communicate with the Profile Optimizer Speech Nodes, you need to

enter the System Settings dialog in the NMC Console and enter the login/password required to

access the Profile Optimizer Server.

You enter this data so that the NMS Server can send data to tasks that run on Speech Nodes, as well

as interact with the Profile Optimizer Server.

Caution:

You must fill in the data under Profile Optimizer Server in the System Settings dialog box before

you allow any providers to dictate.

1. Click on the circle icon with the Nuance logo to the upper left and select System Settings

from the drop-down menu. The System Settings dialog box appears (see next illustration).

2. Click Profile Optimizerand fill in the following values:

l Profile Optimizer Server login—Enter the Windows user account that the NMS Server

should use to access the Profile Optimizer Server and its Speech Nodes. If the server is on a Win-

dows Domain, first supply the domain name followed by a backslash.

l Profile Optimizer Server password—Enter the password that the NMS Server should use

to access the Profile Optimizer Server.

l Confirm password—Re-enter the password.
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Starting Nuance Management Server
and Profile Optimizer Server services

After the NMS and Profile Optimizer servers are installed, if the services do not start on their own,

be sure that the account the servers are running under has Windows administrator level privileges,

has rights to start a service, and that the same account is the one all entities are running on all

servers and (if Windows-based) file servers of the entire Dragon Medical Enterprise network, includ-

ing NMS Server, Profile Optimizer Server, all Speech Nodes and the machine hosting the master user

profiles directory.

Caution:

The account running the services for the NMS Server, Profile Optimizer Server, and Speech Nodes must

have full access rights on all those machines and on the machine that hosts the master user pro-

files.

Changing the account running NMS Server
If you had no trouble entering the user account the server should run under during the NMSServer

installation, skip to the next subsection, Starting NMS Server service on page 80.

If during the installation you were forced to change the account that the NMS Server runs under to

the local administrator or local system account, you need to change that account to the same one

that the other servers are running under (such as NMSapps):

1. Click Start > Control Panel and double click Administrative Tools, then double click Serv-

ices.

2. In the Services list, find the Nuance Management Service.

3. Right click on the service name and select Properties to open its

Nuance Management Service Properties dialog box.

4. Click the LogOn tab and in the This Account text box enter the domain and user name of the

account that all DME services should run under, separating them with a backslash:

<DOMAIN>\<user name>

5. Enter the password in the Password and Confirm Password text boxes.

6. Click Apply to change the account and then click OK to close the dialog box.

7. Now you are ready to start any DME services that do not automatically start.

Starting NMS Server service
After you are sure you have all the necessary privileges, to start NMS Server service:

1. Click Start > Control Panel and double click Administrative Tools, then double click Serv-

ices.

2. In the Services list, find the Nuance Management Service.
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3. To start the service, right click on the service name to open its Nuance Management Serv-

ice Properties dialog box.

4. If the Startup type is not set to Automatic select Automatic from the drop-down list.

5. Click the Start button in the lower third of the dialog box.

6. Click OK to close the dialog box.

7. If you have Profile Optimizer components installed on the same machine as the Nuance Management

Server components, to Starting Profile Optimizer services on page 81NMC Console, proceed to Log-

ging in to the NMS Server through the NMC Console on page 77.

Starting Profile Optimizer services
After you are sure you have all the necessary privileges, to start the services of the Profile Optimizer

or for one or more Profile Optimizer Speech Nodes:

1. Click Start > Control Panel and double click Administrative Tools, then double click Serv-

ices.

2. In the Services list, find the following services for the Profile Optimizer Server:
l Profile Optimizer Core Services

l Profile Optimizer Host Manager

l Profile Optimizer NMS Integration

If a Speech Node is installed on the machine, you see the service for the Profile Optimizer

 Speech Nodes:

l Profile Optimizer Speech Node

3. Start each service manually by clicking on the Service name to open its <Service Name> Prop-

erties dialog box.

4. If the Startup type is not set to Automatic select Automatic from the drop-down list.

5. Click the Start button in the lower third of the dialog box.

6. Click OK to close the dialog box.

81



Dragon Medical Enterprise (DME) Network Edition Installation Guide

7. Additional privileges may be required to start the Profile Optimizer Speech Nodes. For more infor-

mation see Installing Profile Optimizer Speech Nodes on independent machine(s) or virtual machine(s) on

page 65.

8. If you have not already done so, verify that you can start the NMC Console (see Logging in to the

NMS Server through the NMC Console on page 77).

Starting Profile Optimizer Speech
Nodes

Running Profile Optimizer Speech Node service
Once you have installed Profile Optimizer Speech Nodes, to be sure the Speech Nodes are running and

to start them if they are not:

1. Click Start > Control panel and double click Administrative Tools to open the Admin-

istrative Tools dialog box.

2. Find and double click Services. The Services dialog box opens, displaying a list of services

installed on the machine.

3. Look in the Name column for the Profile Optimizer Speech Node service. Double click on

the service name to open its Properties dialog box.
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4. In the Startup type drop-down list, if the service is not already set to start automatically, select

Automatic.

5. Under Service status, click the Start button to the left.

6. After the Service status says Started, you can click OK and close the dialog box.

Giving yourself rights to start the service
If you cannot start the Profile Optimizer Speech Node, you might have only had privileges to install

the Speech Node; that means you might not have privileges to run the service that launches the

node.

If you have Log on as Service level privileges, then the SPARK Speech Node Manager serv-

ice should start immediately. If you do not have that privilege, you might receive the error shown

below:

83



Dragon Medical Enterprise (DME) Network Edition Installation Guide

A quick way to correct this problem in the is to enter your credentials in the Service Control

Manager by taking these steps:

1. Click Start > Control panel and double click Administrative Tools to open the Admin-

istrative Tools dialog box.

2. Find and double click Services. The Services dialog box opens, displaying a list of services

installed on the machine.

3. Look in the Name column for the Profile Optimizer Speech Node service. Double click on

the service name to open its Properties dialog box.
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4. Click the Log On tab, then to enter a network domain level user's login and password, click

This account and enter the domain and user name of the individual who should have access

and enter it in the format of <DOMAIN>\<username> with a backslash between them. The

user must be a Windows administrator level user.

To allow a local machine user to have access, click This account and enter

<machineName>\<username> with a backslash between them or .\<username>, where .\ pre-

cedes the login name.

Next, you prepare to log in to the NMC Console by first installing the Nuance certificates on the

workstation you want to log in on. Proceed to Installing Nuance certificates on page 74.
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Ensuring DME server anti-virus
recommendations are met

Nuance recommends anti-virus software on all Dragon Medical Enterprise Network Edition servers and

clients to protect the system from potential downtime due to viruses. However, be aware of the

recommended restrictions.

After you have installed the servers, be sure to exclude from the anti-virus scan any files found in

the folders indicated below or with the extensions listed below.

On NMS Servers, Profile Optimizer Server, SQL Database Server:

n Nuance folder and all subfolders

n Files with these extensions:

DAT, DRA, ENH, INI, LCK, LOG, NWV, SIG, TXT, USR, VER, VOC, WAV
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Choosing master user profiles
location for a site

For each site of your DME Network you must determine where on the network the master user

profiles should be located. In fact, a DME site is, by definition, a facility location or group of facil-

ity locations in your organization that use the same server location for their user profiles. If all of

your user profiles are stored in a single server location, your organization needs only one site.

All user profiles for a single site should be in their own subdirectory of the master user profiles

directory.

The NMS Server lets you store you master user profiles on a Windows server, a networked Win-

dows workstation (a server is not required), or a web server with or without SSL—this last option

allowing you to access your master user profiles over the Internet. (The machine storing the

master user profiles must be Windows-based.)

If you choose to use a networked Windows server or workstation, you should determine the path

to where the master user profiles will reside and be able to access it any of these ways:

n Mapped Drives—Connects to a shared network folder that has a drive letter assigned to it.

n UNC Paths—Connects to a shared network folder using the Universal Naming Convention

(UNC) to locate a user. The UNC is a way to identify a shared file on a computer or network

without having to know the storage device it is on. Format is:

\\<servername>\<sharename>\<path>\<filename>.

n HTTP (http:)—Connects to machine on the Internet or your local intranet running a web

server. Format is: http://<myserver.com>/<webdav>

n HTTP with SSL (https:)—Connects to machine on the Internet or your local intranet running a

secure socket layer (SSL) web server. Format is: https://<myserver.com>/<webdav>

The location(s) you select must be accessible to all computers where healthcare providers dictate.

Each location must have adequate storage space for the master user profiles.

Caution:

If the master user profiles directory is on a separate server or workstation, you must share the top

level master user profiles directory in Windows and give Everyone full read/write/modify con-

trol over the directory, so that the Dragon Medical Client can write to those directories when it

creates the master user profile for each healthcare provider.
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Caution:

Be sure that when you set up the master user profiles directory, you locate it either on a Windows

machine or on a device connected to a Windows machine with .NET Framework 3.5 SP1

installed on it and that the machine is in the same Windows domain as your DME servers.

If you choose to use server, choose one of the supported web servers.

Supported Web Servers

n Microsoft Internet Information Services (IIS) 6.0 on Windows Server 2003

n Microsoft Internet Information Services (IIS) 7.0 or 7.5 on Windows Server 2008

n Apache HTTP Server 2.0.54 and higher on Windows Server 2003

n Apache HTTP Server 2.2.16 and higher on Windows Server 2008

Information required for setting up Web Server

If you have chosen to store the master user profiles on a web server or secure web server, you

should determine the following information so that you can tell Dragon how to connect to the

HTTP server:

n The network location—You need to know the URL address of your HTTP server.

n HTTP settings—For your http (or https) connection you need to know authentication,

firewall, and proxy server information.

n SSL settings—For your https connection you need to know Certificate store information, and

the type(s) of SSL protocols used.

n If you are using Open SSL, you need the locations of the cipher list, certificate authority file,

and certificate authority directory.
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Setting up machine to host master
user profiles

Caution:

If you have proxy servers in your network, they must all point to the machine hosting the master

user profiles.

Any time after you have installed the NMS Server and started its service (even before you have the

Profile Optimizer Server installed or running), you can set up the machine that hosts your master user

profiles by taking these actions:

n Creating master user profile directory on page 90

n Mapping disk drive on the client workstation on page 90

n Setting up server/client access to the master user profile directory on page 91

Creating master user profile directory
On the machine that you selected to host the master user profiles for DME network:

Caution:

Be sure the machine is a Windows server or workstation with .NET Framework 3.5 SP1 installed

and that the machine is in your Windows domain. If you are using a RAID array, be sure to attach

the device to a Windows machine meeting these requirements. The requirements that machine be

a Windows machine with specific software installed differ from roaming user storage requirements

for previous non-network editions of Dragon Medical.

1. Create a directory to store the profiles. You can have more than one directory for profiles, but

you should store all user profiles from providers at the same site in the same location.

2. Write down the machine name and full path to the directory.

Mapping disk drive on the client workstation
On the workstations where you have the Dragon Medical Client installed or in the Windows user pro-

files of all providers who will later dictate:

If your workstations uses a mapped drive to access the master user profiles, map a drive letter to

the location where the master user profiles are located on every machine running the Dragon Med-

ical Client. This mapping must be the same on every workstation and every Windows user profile.
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Setting up server/client access to the master user
profile directory
On any network machine:

1. Log in to the NMC Console. Refer to Logging in to the NMS Server through the NMC Console on page

77.

2. If you do not already have a site defined for this set of master user profiles, create the site under

your organization by clicking the Add Site icon. Be sure to provide data in the highlighted text

boxes (where data is required) and then click the Dragon settings tab. (For more details, see

the Nuance Management Server Administrator Guide.)

3. Under the Dragon settings tab, click the Configure button and theMaster Profiles Settings

 dialog box appears with the General tab open.

4. Fill in the following text boxes:

l Name—Enter the name that you want to appear in the Dragon Medical Client GUI to indi-

cate that the provider is working with a master user profile from this netweork network

rather than a local copy.

l Location—Enter the path that the NMS Server sends to the Dragon Medical Client. The

Dragon Medical Client uses this path to access the master user profiles from the workstation.

Click the magnifying glass icon to the far right in the text box. When the Search for Folder

dialog box appears, browse through it and find the machine, then the directory where the

master user profiles reside or type the full path directly into the text box. Or explicitly enter
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the path. The location must be accessible to all server machines and workstations on the net-

work and can be either a mapped drive, a UNC location, or a web server URL (http:// or

https:// for a secure web server). If you cannot browse to the location, when you explicitly

enter the path, be sure it is in the format shown in the dialog box, based on the way servers

on your network will access the master user profiles location:

l NMC UNC Path—Enter the path that the NMS Server uses to find the master user pro-

files. You must enter a UNC path in the format \\machinename\profilesdirectory. Click the mag-

nifying glass icon to the far right in the text box. When the Search for Folder dialog box

appears, browse through it and find the name of the machine where the master user profiles

reside, then browse through to the exact location or type the UNC path into the text box.

Or you can enter the path explicitly. The machine must be accessible by all server machines

and workstations on the network.

5. If you have set up a web server for your profiles, after you enter the http:// URL in the Loca-

tion text box and the UNC to the path for the NMS Server in the NMC UNC Path text box,

click the HTTP Settings tab and enter your web server information.

6. If you have set up a secure web server for your profiles, after you enter the https:// URL in

the Location text box and the UNC to the path for the NMS Server in the NMC UNC Path

text box, click the SSL Settings tab and enter your secure web server information.

7. If you have a mapped drive or UNC location for your profiles, after you enter the mapped drive

as S:\ or S:\<profilesdirectory> in the Location text box, or enter the UNC path as \\<machine-

name>\<profilesdirectory> in the Location text box, you enter the UNC to the path for the NMS

 Server in the NMC UNC Path text box.

8. Click Save to save the settings and close the dialog box.

9. If you have not already done so, be sure you have assigned appropriate access rights to appro-

priate types of DME users, as outlined in Assigning access to servers, clients, master user profiles across

network on page 4.

10. If you have roaming user profiles from an earlier version of Dragon Medical and would like to

upgrade them for use with Dragon Medical Enterprise Network Edition, refer to the instructions pro-

vided, starting with Preparing to upgrade Dragon Medical Clients to Network Edition on page 114

Opening client ports to access user profiles on web
server or secure web server
Caution:

It is critical that if they are not already open, you open the ports required for the Dragon Medical

Client to access the master user profiles on a web server or secure web server.

To allow the Dragon Medical Client to access master user profiles on a web server (http) that is not

SSL, open port 80.

To allow the Dragon Medical Client to access master user profiles on a secure (SSL) server (https),

open port 443.
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Installing software required to store
master user profiles on web server

Caution:

If you have never set up a web server or secure web server before, do not attempt to do so; these

instructions assume you have experience setting up a web server. Appropriate settings vary.

After you install the NMS Server and NMC Console, if you choose to store your master user profiles

on a web server or secure web server, be sure you have the correct type of server, download the

required software, and make the correct selections while installing the web server.

Note:

Storing your master user profiles on a web server or secure web server is entirely

optional. You can choose to store them on a mapped drive, on any DME Network

physical server or workstation with adequate storage space, or on their own Windows

server or workstation within your network's domain without using a web server at all.

To store the master user profiles on one of the web servers below, first be sure you have .NET

Framework 3.5 SP1 installed as well as the associated WebDAV software for the server. For more

information, visit the software provider's site (some links below are provided for reference):

n Microsoft Internet Information Services (IIS) Version 7.0 or 7.5 0 on Windows Server 2008:

l 32-bit Version: http://learn.iis.net/page.aspx/350/installing-and-configuring-webdav-on-

iis-7/webdav_x86_75.msi

l 64-bit Version: http://learn.iis.net/page.aspx/350/installing-and-configuring-webdav-on-

iis-7/webdav_x64_75.msi

n Microsoft Internet Information Services (IIS) Version 6.0 on Windows Server 2003: Refer to

Installing Microsoft Internet Information Services 6.0 web server (optional) on page 94.

n Apache Server 2.2.16 or higher on Windows Server 2008:

This server should run on Windows Server 2008 Core and also runs on Windows 7 or Vista.

For more information see:

l http://httpd.apache.org/docs/2.2/platform/windows.htm

l http://www.markwilson.co.uk/blog/2007/07/apache-http-server-on-windows-server-

2008-server-core.htm

l http://www.thesitewizard.com/apache/install-apache-on-vista.shtml

n Apache Server 2.0.54 or higher on Windows Server 2003.

For more information on installing Apache web server, see: http://www.apache.org/
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Installing Microsoft Internet
Information Services 6.0 web server
(optional)

Caution:

If you have never set up a web server or secure web server before, do not attempt to do so; these

instructions assume you have experience setting up a web server. Appropriate settings vary.

You install a Microsoft Internet Information Services 6.0 web server on a Windows Server 2003

system. With that version of the operating system, you receive IIS 6.0 and the WebDAV module.

To install an IIS 6.0 web server, take these general steps:

n Install IIS 6.0 web server and its WebDAV module on the physical server.

n Customize the web server settings for Dragon Medical.

n Configure HTTP or SSL settings in the NMC Console.

Installing IIS Server and WebDAV component on
physical server
To install IIS 6.0 and the WebDAV module in Windows Server 2003 or 2003 R2:

1. Log on to the server as a local Windows administrator user.

2. Go to your server desktop and click Start > Control Panel, then click Add or Remove Pro-

gram.

3. Once the Add or Remove Programs dialog box opens, look down along the left vertical bar

and click the Add or Remove Windows Components icon to start the Windows Com-

ponents Wizard.

4. When the wizard appears, check the check box for Application Serverand highlight the selec-

tion and, when the Details... button becomes available, click the button to open the Appli-

cation Server dialog box.

Caution:

Do not uncheck any of the already checked boxes or the wizard will uninstall those components.

5. In the list, check the check box for Internet Information Services and highlight the selection,

then click the Details... button to open the Internet Information Services dialog box.

6. In the list, check the check box forWorld Wide Web Service and highlight the selection, then

click the Details... button to open the World Wide Web Service dialog box.

7. In the list, check the check box forWebDAV Publishing.
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8. Click OK in each successive open dialog box until you return to the wizard; then click Next to

initiate the installation.

9. When the Completing the Windows Components Wizard page of the wizard appears, to exit

the wizard, click Finish.

10. To ensure WebDAV is enabled or enable it if it is not, select Start > Programs > Admin-

istrative Tools > Internet Information Services (IIS) Manager and expand the IIS Explorer

in the left pane.

11. Select Web Service Extensions (below Web Sites) and, in the right pane of the IIS Manager

dialog box, select WebDAV, then click Allow to change its Statusto Allowed (see next illus-

tration).
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Customizing web server settings for Dragon
Medical
Note:

Do not choose Digest authentication, as the DME Network does not support the option for an

IIS web server housing the master user profiles.

Caution:

You should not give the right to log on locally to healthcare providers dictating with Dragon Med-

ical Client. Only administrator level users should have log on rights to the web server hosting the

master user profiles.

To customize the web server settings for the Dragon Medical Enterprise master user profiles:

1. Create a virtual directory for the web server. To create that virtual directory using Windows

Explorer:

i. Open Windows Explorer.

ii. Right-click the folder you want to be a virtual directory, and click Sharing and Security.

iii. Click the Web Sharing tab and then click Share this folder.

iv. In the Alias text box, type the name for the virtual directory, the select the permissions

under Access permissions and Appliction permissions.

v. Click OK in the Edit Alias dialog box, then OK again Properties dialog box.

2. To open the IIS Manager, select Start > Programs > Administrative Tools > Internet

Information Services (IIS) Manager.
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3. Add wildcard MIME mapping to the virtual directory. Dragon Medical Client requires this type of

mapping. Take these steps in the IIS Manager:

i. Right click on the local computer name and select Properties from the drop-down menu.

ii. In the local computer Properties dialog box, click the MIME Types button.

iii. In theMIME Types dialog box, click the New... button.

iv. In the Extension text box, type an asterisk (*).

v. In theMIME type text box, type application/octet-stream.

vi. Click OK until you return to the Internet Informatin Services tab, where you click Apply

to apply the changes and OK to close the dialog box.

4. In the IIS Manager, expand the tree under the local computer by double-clicking on it; then

right-click the Default Web Site folder (or your individual Web server folder or the virtual
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directory) and select Properties. You see several tabs where you enter information about the

web site. The tabs you fill out for your master user profiles web server are:

l Web Site

l Virtual Directory orHome Directory

l Directory Security

Entering settings under Web Site tab

You should enter these settings under the Web Site tab:

1. Click the Web Site tab.

2. UnderWeb site identification, enter:
l Description Optional. Master user profiles web server.

l IP address Set to IP address of this machine.

l TCP port Set to 80.

l SSL port Set to 443 only if you are creating a secure (SSL) web server.

3. Under Connections, enter:
l Connection timeout 120 seconds.

l HTTP Keep-Alives Check the check box to enable them.
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4. Under Enable logging, enter:
l Active log format Select W3C Extended Log File Formatfrom the drop-

down list.

l (Optional) Click the Properties... button to set up logging options.

5. Click Apply and proceed to either the Home Directory tab or the Virtual Directory tab.

Entering settings under Virtual Directory or Home Directory tab

You should enter these settings under the Virtual Directory orHome Directory tab:

4. The content for this resource should come from—Select A directory located on this

computer.

5. Local path—Enter the full path to the web site folder. If you use the default folder, the path is

C:\Inetpub\wwwroot.

6. Check off the following check boxes under the local path to indicate the kind of access to the

master user profiles you want to grant to the user accounts running the other services of the

DME Network:
l Read

l Write

l Directory Browsing

99



Dragon Medical Enterprise (DME) Network Edition Installation Guide

l Log visits

l Index this resource

7. Application name—You should see the name you gave to your virtual directory, in this case

MasterUserProfiles.

8. Execute permissions—Select Scripts and executables from the drop-down list. You need

the option of running executables on the master user profiles so that the acoustic and language

model optimization results can be integrated into the profiles. When you choose this selection,

the IIS Manager warns you that you could be exposing the site, so be sure your firewall and

other security precautions are adequate to protect the site from malicious attack.

To avoid giving permission to run scripts on the entire machine, be sure that you set the per-

missions to Scripts and executables only on the virtual directory, not on its parent directory.

9. Application pool—Select DefaultAppPool from the drop-down list.

10. Click Apply to apply the changes.

Entering settings under Directory Security tab

Under the Directory Security tab, you select Basic authentication for the virtual directory you

created for your web server. You also view and verify certificate information that ensures the iden-

tity of the computer if you are installing the software on a remote computer, rather than locally.

Caution:

Basic authentication transmits user names and passwords across the network in an unencrypted

form. You must use your web server's encryption features to ensure the security of login infor-

mation.

To use Basic authentication to control access to your web server, you grant each Windows

administrator account that needs access the right to log on locally. (You can add each admin-

istrator to a group and then give the group access to the necessary files.)

Caution:

You should not give the right to log on locally to healthcare providers dictating with Dragon Med-

ical Client. Only administrator level users should have log on rights to the web server hosting the

master user profiles.
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1. To enable Basic Authentication:

i. In the Authentication and access control section, click the Edit... button.

ii. When the Authentication Methods dialog box pops up, check off Basic authentication.
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iii. When you are warned that this type of authentication passes unencrypted passwords over

the network, click Yes to proceed.

iv. Be sure that if you see a check mark in the check box for Enable anonymous access you

click it to remove the check mark. For security reasons, you should not allow anonymous

access.

v. Leave the Default domain text box empty to have the domain name be the name of the

machine itself when a party accessing this web server does not provide the domain name.

vi. Click OK to save the changes and return to the Directory Security tab. If you are setting

up a secure (SSL) web server, proceed to the next step. Otherwise, skip to step 5.

2. If you are setting up a secure (SSL) web server, for the web server to selectively allow only

Dragon Medical Client machines access to the master user profiles, you need to require that the

web server enable security certificates on any client that tries to access the web server. Take

these steps:

i. In the Secure communications section, click the View Certificate... button.
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ii. When the Certificate dialog box pops up, under the General tab you should see Cer-

tificate Information indicating that this certificate's purpose is to ensure the identity of the

remote system seeking access.

iii. Under the Certification Path tab, click the View Certificate button and again under the

General tab you should see root Certificate Information that ensures the validity of all

issuance and application policies.

3. If the View Certificate... button is not available, you can purchase an SSL certificates on the

web and install it. The button should then become available. For more information on pur-

chasing and installing an SSL certificate, you can visit http://www.rapidssl.com/index_ssl.htm

or a similar site.

4. For instructions on installing an SSL certificate, visit http://www-

.rapidssl.com/resources/install/chainedssl/MS_IIS5.html.

5. Click Apply to apply all changes in the Directory Security tab and then click OK to close the

dialog box.

Now that you have finished entering all of the settings for the web server, restart the World Wide

Web Publishing Service or wait for the process to recycle for the changes to take effect.

Caution:

You must share the top level master user profiles directory in Windows and give Everyone full

read/write/modify control over the directory, so that the Dragon Medical Client can write to those

directories when it creates the master user profile for each healthcare provider.

Configuring HTTP or SSL settings in NMC Console
Later, when you set up sites in the NMS Server, to set up access to the master user profiles, you

enter HTTP settings for interacting with a non-secure web site or SSL settings for interacting with

a secure web site. For details, refer to the related topics in the NMC Console Help or the Nuance

Management Server Administrator Guide.

For specific HTTP settings that you should enter in the HTTP Settings tab in the NMC Console

for this type of web server, refer to Setting HTTP connection settings for web server on page 106.

For specific SSL settings that you should enter in the SSL Settings tab in the NMC Console for

this type of web server, refer to Setting SSL connection settings for secure web server on page 108.
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Installing SSL certificates for IIS 6.0
1. After you have downloaded an SSL certificate for IIS, the View Certificate... button becomes

available under the Directory Security tab.

2. Click the View Certificate... button to see the certificate and verify that it is valid. It should

look something like the one shown below.

Note:

All certificates should be valid, not expired, free of errors, and properly signed.

3. Keep the certificate open and click the Certification Path tab to display the path to the cer-

tificate that Dragon Medical Client workstations will need to follow.

4. In the Certification Path tab, expand the path in the Certification path box. The Certificate

Status text box near the bottom of the dialog box should say This certificate is OK.(See the

next illustration.)
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5. Click the next View Certificate button and view the certificate for All Issuance and Appli-

cation Policies to be sure it was issued to the correct organization and is valid for the expected

time period.

6. Install the Root Certificate for All Issurance and Application Policies (see previous illus-

tration) on every Dragon Medical Client workstation and install it to Trusted Root Certification

Authorities.

Caution:

If you do not install the above certificate on every Dragon Medical Client workstation, when the

workstation attempts to access a master user profile on the web server, the provider will receive

this error: This Certificate cannot be verified up to a trusted certification authority.

When you save the certificate, be sure to save it to <PC-name>/<Site-name> where the PC-name

matches the name of the computer and the Site-name matches the name of the site you created in

IIS Manager. Or you can save it to a name that matches the Active Directory host name.
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Setting HTTP connection settings for
web server

Caution:

If you have never set up a web server before, do not attempt to do so; these instructions assume

you have experience setting up a web server, and appropriate settings to use vary.

After you install your web server, you must set HTTP connection settings in the NMC Console.

For details on how to set up a site, refer to the Nuance Management Server Administrator Guide.

Note:

You set these HTTP Settings only to store master user profiles on a web server.

Making selections on HTTP Settings tab
The next table shows the settings you should select for each type of web server (not using SSL).
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Recommended HTTP settings for particular web servers

Web Server
Type & Version

IIS 6.0,
7.0, or
7.5

Apache
2.0.xx or
2.2.xx

Other Considerations
Based on Your Site Configuration

Authentication

Prompt for user
and password

Off Turn off to prevent prompt for a username/password
when Dragon Client accesses master user profiles.

Default user Empty Enter username for the account that the servers run
under, such asNMSapps.

Password Empty Enter password for the account that servers run under.

Authentication type Basic Basic or
Digest

For IIS, always choose Basic. For Apache, choose type you
set up on the web server.Basic authentication sends
transmits as plain text.Digest authentication transmits
passwords in encrypted form.

Firewall and Proxy Servers

Use proxy server Off Check (On) if you are connecting through a proxy server.

Type HTTP HTTP for web page transactions. Tunnel if you are using
tunneling software. Socks4 for SOCKS4 pro-
tocol/transparent client access across firewall. Socks5 for
SOCKS5 protocol/transparent access across firewall and
SOCKS5 server DNS lookup.

Server Empty Enter name of the proxy server.

Port Empty Enter number of port for proxy server or firewall.

User Empty Enter user name for logging in to proxy server or firewall.

Password Empty Enter password for logging in to proxy server or firewall.

Firewall data Empty Enter any special authentication string required.

Miscellaneous

Follow redirects Off Always or
Same
Scheme
Only

Never turn off. Handles redirects of incoming connections.

Keep connection alive Off Could be turned on even if turned off for the site. If on,
keeps the connection alive after current communication
ends, which can be useful if the connection setup process
involves multiple message transfers between the web
server and the client or server interacting with it. Should
be off if you have Follow Redirects set to anything other
then Never.

Lock timeout 0 Must always be 0, so that no user is ever locked out.

Connection timeout 60 Must be 60.

Timeout of inactive On Must be On.
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Setting SSL connection settings for
secure web server

Caution:

If you have never set up a secure web server before, do not attempt to do so; these instructions

assume you have experience setting up a secure web server. Appropriate settings vary. Be sure

that you install an SSL certificate that is trusted for directory on every workstation. You should

push install the SSL certificate as Trusted Root Certificate Author.

After you install your secure web server, you must set SSL connection settings in the NMC Con-

sole. For details on how to set up a site, refer to the Nuance Management Server Administrator Guide.

Note:

You set these SSL Settings only to store your master user profiles on a secure web

server.

Settings on SSL Settings tab
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Recommended settings for SSL web servers
The table below shows the settings you should select for various versions of each type of secure

web server. In general, you have flexibility in selecting these settings and should select those

appropriate for your installation.

Recommended settings for particular secure web servers

Web Server Type
& Version

IIS 6.0,
7.0, or 7.5

Apache
2.0.xx or
2.2.xx

Other Considerations
Based on Your Site Configuration

Certificate store

CCCertificate store
type

User
Store

User
Store

CCCertificate store My My

CCCertificate store
password

Empty Empty

SSL Protocols

Use general SSL
protocols

On On Check all protocols your server might receive legit-
imate input from: TLS1, SSL3, SSL2, andPCT1.

Use Open SSL On On

CCCipher List String of ciphers if applicable. These options apply only if you are usingOpenSSL as
a Certificate Authority.

Refer to the Nuance Management Server
Administrator Guide for details.

CCCertificate
authority file

Name of file containing list of
certificate authorities to
trust.

CCCA directory Path to the directory where
certificate authority cer-
tificates reside.
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Assigning access to folders and
master user profiles across network

Caution:

Windows accounts that all NMS and Profile Optimizer processes on the network run under, even

the Dragon Medical Client, must have read permission to the following:

<Drive Letter>:\Program Files\ folder and all subfolders

Assigning permissions to NMS and Profile Optimizer
component files
To ensure all NMS and Profile Optimizer processes can interact with one another, during the instal-

lation you set up a single administrator level account (name it something like NMSapps) that all

the software will be running under and give full access rights across all servers to the directories

where you install the software. The software these conditions apply to includes:

n NMS Server

n NMC Console

n NMS SQL Database

n Profile Optimizer Server

n Profile Optimizer Database

n Each Profile Optimizer Speech Node

Caution: Run All Services under the same Windows user account

All services should run under this same Windows administrator level account with full access

rights across all servers and the master user profiles directory.

Directories where the components are installed should have full read/write/modify permissions.

Caution: Ensure Full access to the Master user profiles directory

It is especially important that the account that NMS and Profile Optimizer components run under

has complete read/write/modify access to the master user profiles directory. If the servers and

Speech Nodes cannot access the master user profiles, the DME product cannot function properly.

Each windows user account that logs in to the Dragon Medical Client workstation should also have

access to the master user profiles that allows reading profiles and writing to/modifying profiles, an

action the Dragon Medical Client takes frequently to keep profiles current.
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Caution: Regarding Privacy of Patient Data

To protect the privacy of patient data and the integrity of the master user profiles, you should not

give Windows user accounts of Dragon Medical Clients rights to log in to the master user profiles

machine; the Dragon software writes to and modifies the profiles in the background.

Assigning permissions to master user profiles
Caution:

Be sure that when you set up the master user profiles directory, you locate it either on a Windows

machine or on a device connected to a Windows machine with .NET Framework 3.5 SP1

installed on it and that the machine is in the same Windows domain as your DME servers.

To ensure every dictating healthcare provider has appropriate access to files (such as his or her

user profile), you must give full read/write/modify permissions to all files and directories housing

the master user profiles for healthcare providers that dictate on that client or allow the same level

of access to the master user profiles through an http or https connection. This level of per-

mission/access ensures that when the provider dictates, the software can interact with the master

user profiles effectively.

Assigning folder permissions to Dragon Medical
Enterprise server and client files
You must assign particular levels of permissions to certain folders that Dragon Medical Client reads

from and writes to when processing speech.

NMS Servers/NMS and Profile Optimizer Databases:

<Drive Letter>:\Users\All Users\Application Data\Nuance folder and all

subfolders:

All users must have read, write, and modify permissions.

<Drive Letter>:\Program Data\Application Data\Nuance folder and all

subfolders:

All users must have read, write, and modify permissions.

<Drive Letter>:\Program Files\Nuance folder and all subfolders:

All users must have read permission.
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Dragon Medical Client workstations (Windows 7, XP, and Vista):

<Drive Letter>:\Program Data\Nuance folder and all subfolders:

All users must have read, write, and modify permissions.

<Drive Letter>:\<Windows_user_ID>\AppData\ folder and all subfolders:

All users must have read, write, and modify permissions.

<Drive Letter>:\Documents and Settings\All Users\Application

Data\Nuance folder and all subfolders:

All users must have read, write, and modify permissions.

Assigning Dragon Medical Clients access to registry
keys
You must assign particular levels of access to certain registry key settings. You assign these rights

to all Windows user accounts for all dictating healthcare providers using Dragon Medical Client .

Dragon Medical Client workstations:

Workstation Windows user accounts that Dragon Medical runs under must have rights to update the

registry in order to read/write to particular keys in the registry:

HKEY_LOCAL_MACHINE\SOFTWARE\Nuance

HKEY_CURRENT_USER\SOFTWARE\Nuance

Turning off Automatic Updates
On each machine you plan to use in the DME Network, be sure to turn off Windows Automatic

Updates. You should, instead, qualify each update Windows sends by installing it first on a single

test machine of the network and then updating other machines on the network only after you

determine that it clearly will not disrupt the network.

Once you are sure an update does not negatively affect DME, you should install the update during

off-hours and, if required, reboot each machine during those hours to ensure that requests to

reboot do not disrupt the DME servers or workstations during peak hours of dictation.
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Preparing to upgrade Dragon Medical
Clients to Network Edition

If you are planning to install the Dragon Medical Client for Dragon Medical Enterprise Network Edition

on a computer where Dragon Medical 10.1 is already installed, you do not have to uninstall the non-

Network Edition first. However, Nuance recommends you uninstall Dragon Medical first if doing so

would not disrupt the operation of your medical facility.

Before you begin to upgrade from non-Network
Edition Dragon Medical—Overview of process
If you choose to uninstall the non-Network Edition of Dragon Medical, you should be sure to take

these steps first:

n Save and back up all user profiles.

n If you have any local users (not roaming) from Dragon Medical 10.1 (non-Network Edition),

prepare to migrate them to the Network Edition as explained in Converting local user profiles to DME

master user profiles on page 127

n Save any Dragon Medical 10.0 roaming user profiles to a location where the NMS Server can

access them.

n Upgrade any user profiles from Dragon Medical 8.x or 9.x and save the upgraded user profiles to a

location where the NMS Server can access them. For details on upgrading roaming user profiles,

see Upgrading Dragon 8.x and 9.x roaming user profiles to DME on page 1.

n Uninstall the previous edition of Dragon Medical (optional, but recommended).

n Install the new Dragon Medical Enterprise Network Edition client on each client workstation.

Note:

The term roaming user profiles has been changed for DME. Since all users of the DME Network

are roaming by definition (the master copy of their profiles always resides on a central machine), the

profiles stored on a central machine are now calledmaster user profiles. When a provider dic-

tates, the Dragon Medical Client retrieves a copy of the master user profile and that copy is called

the local cache user profile.

When you upgrade previously existing roaming user profiles or local user profiles for use with

DME, these profiles all become master user profiles.
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Overview of migrating local users from Dragon
Medical Version 10.1
If you have local users from Dragon Medical 10.1, to migrate them to Network Edition, you take

these general steps:

1. ICreating user accounts for healthcare providers on page 117

2. Export the local user profiles to a different location, so that the action you take does not affect

the user profiles of dictating providers.

3. Enable the Roaming feature on the workstation and save the local users to the roaming user

location.

4. Export each roaming user profile to a location where the NMS Server can access it.

4. Create user accounts in NMS Server for the healthcare providers dictating with the local user pro-

files you are converting.

5. Associate the user accounts with the master user profiles for the corresponding healthcare pro-

fessionals.

For more details, refer to Converting local user profiles to DME master user profiles on page 127.

Overview of upgrading roaming user profiles from
Dragon Medical Version 10.0 to 10.1
If you have pre-existing roaming user profiles from Dragon Medical Versions 10.0, you can skip the

step of upgrading those profiles and proceed immediately to Associating new user accounts with upgraded

user profiles on page 134.

Overview of upgrading roaming user profiles from
Dragon Medical Version 8.x or 9.x
When you have pre-existing roaming user profiles from Dragon Medical Versions 8.x or 9.x, to allow

healthcare providers to dictate using those profiles in Dragon Medical Enterprise, you take these

steps:

1. In the NMC Console, create user accounts for each healthcare provider, as described

in Creating user accounts for healthcare providers on page 117

2. Upgrade roaming users to DME, as described in Upgrading Dragon 8.x and 9.x roaming user profiles

to DME on page 119

3. Associating new user accounts with upgraded user profiles on page 134.
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After you install Dragon Medical Client Network
Edition, take these steps on client
After you install the Dragon Medical Client forNetwork Edition, on the new client:

1. Log in to the Dragon Medical Enterprise Client with the NMS Server user account login and pass-

word.

2. Reimport any custom words, commands, and vocabularies as instructed in the Dragon Medical

Enterprise Network Edition Dragon Help.

3. Alternatively, you can also use the Data Distribution Tool to export or import words, com-

mands, or vocabularies. You run the Data Distribution Tool from inside the NMC Console; see

the Nuance Management Server Administrator Guide's chapter on the Using the Data Distribution Tool

for more information.Creating user accounts for healthcare providers on page 117
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Creating user accounts for healthcare
providers

When you are upgrading your roaming user profiles to DME, you begin by creating a user account

for each dictating healthcare provider.

Note:

More details about creating user accounts are available in the Nuance Management Server

Administrator Guide.

To create user accounts:

1. Log in on the NMC Console. For details, see Logging in to the NMS Server through the NMC Console

on page 77

2. On the Menu bar, click on the User Accounts ribbon.

3. When the User Accounts ribbon appears, click the Add User Account icon.

The User Account Details window opens.

4. Configure the options and settings on tabs in the User Account Details window:

l Details—Enter data in the shaded text boxes (required data) for now. Required information

includes the healthcare provider's first and last names and the login.

Caution:

If you are creating a user account to be managed in Active Directory, the login you enter must

match an existing login in Active Directory. If, additionally, you are setting up providers to log in

only once (called Single Sign-On), the login you enter must match the user name that the provider

enters to log in to Windows and must also be a login in Active Directory.
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l Address—Physical location information. None of this data is required right now.

l Group Memberships—If you have created no other groups, two groups exist when you

first run the product, NMC Administration and Dragon Medical. Add the dictating user

account to the Dragon Medical group.

l Dragon Settings—To apply default settings for now, click the Use group rules button.

For more information, refer to Configuring user account Dragon settings in the Nuance Management

Server Network Edition Administrator Guide.

l User Profile—Ignore these settings. The Dragon Medical Client provides them.

3. Click Save to save the user account settings.

4. When you save the user account, the NMC Console pops up a dialog box that asks you if you

want to grant a license to the user account now.

You should click Yes.

5. When the next message asks you the type of license to assign, you can select either a Physician

Author orNon-Physician Author license. The number of licenses available shows in paren-

theses after the license type. If no licenses of a particular are available, that license type is

grayed out. If you need a license that is not available, contact your Nuance representative.

6. Repeat the above steps for each healthcare provider whose profile you plan to upgrade.

7. Depending on the type of user you are creating, return to either the Active Directory or Single

Sign-On instructions, or proceed to the next section,Upgrading Dragon 8.x and 9.x roaming user pro-

files to DME on page 119.

 

Note:

For now, you can skip setting options and other information for the user accounts

that you want to associate with upgraded master user profiles. To later assign all

related user accounts the same option settings, you can:

n Create a group.

n Set all options for that group.

n Add the user accounts that should have those same option settings to the group.

For details on how to carry out these tasks, refer to the Nuance Management Server

Administrator Guide.
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Upgrading Dragon 8.x and 9.x
roaming user profiles to DME

Dragon Medical Enterprise provides an upgrade.exe utility that you can use to upgrade Dragon Med-

ical roaming user profiles from several earlier versions to Dragon Medical Enterprise (DME) Network

 Edition. You can upgrade these profiles from these versions:

n Dragon Medical Version 8.x

n Dragon Medical Version 9.x

When you upgrade these files, you take that action on a workstation you select where you have

installed Dragon Medical SDK Client Edition Version 10.1 rather than on the NMS Server.

You do not have to upgrade user profiles from the Version 10.0 of Dragon Medical. Instead of

upgrading these users, you can just copy them to the master user profiles directory of the DME

network and associate each profile with a user account in NMS Server, as described later in this sec-

tion.

Before upgrading Dragon roaming user profiles
Caution:

n Before you upgrade them, Nuance recommends you back-up your Version 8.x and

9.x roaming user profiles.

n Nuance recommends that you never upgrade your roaming user profiles across a

network to either a mapped drive or UNC path; upgrading over a network will take

an undetermined length of time. In addition, the Upgrade.exe application does

not support upgrading users over an HTTP connection.

n Nuance recommends that you plan to upgrade the Dragon Medical 8.x or 9.x roaming

user profiles at a time when healthcare providers are not using them to dictate,

such as at night or on a weekend. If there is no time when all your user profiles are

not in use (because healthcare providers dictate 24/7), you can upgrade multiple

sets of roaming user profiles at appropriate times.

n Nuance recommends that you migrate user profiles to the location on the DME

network only after you have upgraded them on another machine.

n The upgrade.exe utility can take 2-3 minutes or more to upgrade each roaming

user profile, depending on the speed of your processor and the size of the profile.

The upgrade process creates new master user profiles in the location you specify.
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Upgrading Dragon roaming user profiles with
Upgrade.exe
To upgrade Dragon Medical 8.x or 9.x roaming user profiles to DME master user profiles:

1. Select a machine where you will carry out the roaming user profiles upgrade and, if it is not

already installed, install the Dragon SDK Client Edition Version 10.1. on that machine.

2. If you have multiple sets of roaming user profiles on different machines, create a list of all loca-

tions where you currently have roaming user profiles that you plan to upgrade.

3. Back-up all the existing roaming user profiles to a separate location using the system backup util-

ity at your facility.

4. On each Dragon Medical 8.x or 9.x client workstation where the healthcare providers dictate, save

and close any open users who employ the Roaming User feature.

5. Copy the existing roaming user profiles directories into a folder on the machine where you plan

to carry out the upgrade. In the directory, you see a separate folder for each healthcare pro-

vider's user profile.

6. Create a directory on the same machine where the upgrade utility should place the upgraded pro-

files when they are complete. In the example shown here, the directory is named User-

ProfilesDir.
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7. Find the upgrade.exe file in the C:\Program Files\Nuance\Dragon SDK Client

Edition10\Program directory.

8. Double click upgrade.exe to execute the utility. The User Upgrade Wizard opens, dis-

playing the Select Users to Upgrade page.
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9. Click the Add button and, when the Browse For Folder dialog box appears, find the directory

containing the existing roaming user profiles and click on that directory to highlight it. You

should then see its folder name in the Folder text box below the list box.

10. Click OK and, when the Browse For Folder dialog box closes, notice that in the Select Users

to Upgrade page you can now see the names of all of the users in the folder.
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11. Click Next to begin the upgrade of the user profiles you see listed. When the Choose Des-

tination page of the wizard appears, click the Browse button and browse to the location where

you want the utility to place the upgraded profiles.
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12. While you are in the Choose Destination page of the wizard, you can also click the Advanced

button to open the Advanced Options dialog box. Here you can click on any piece of infor-

mation about a particular user profile and modify its setting.

For instance, on this page you could:

n Place a particular user profile in a special location on the network by setting

the New Location text box:

l Click on the Location under the user profile name and then click the Browse

button to the right of the New Location text box below the list of all profiles.

l Browse to the new location you want and click OK to return to the Advanced

Options dialog box.

n Select a different vocabulary to use as the basis for a particular user profile

vocabulary by clicking on the drop-down list inNew Base Vocabulary text box

and selecting the vocabulary you want.

n Select a different acoustic model to use as the basis for a particular user profile

acoustic model by setting the New Acoustic Model text box:

l Click on the drop-down list inNew Acoustic Model text box and select the

vocabulary you want.
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13. Click OK to return to the User Upgrade Wizard and click Next to proceed to the Upgrade

 Users page of the wizard.

14. Press the Begin button to start the upgrade process.

15. If at any time during the upgrade process you want to cancel it, click the Stop button.

When you click Stop, the wizard backs out of the process and restores the user profiles to their

previous state.
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16. When the upgrade process is complete, you can click the Details... button for more infor-

mation. When you are satisfied that the users have been updated, click the Finish button and

the wizard closes.

17. Find the new upgraded profiles in the destination folder you directed the wizard to place them

in. Notice that upgrade.exe renames each master user profile in the format name(v10), as

shown in the next illustration.

18. Copy the new profiles to the new master user profiles directory on the DME Network.

19. Proceed to the next section, Associating new user accounts with upgraded user profiles on page 134.
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Upgrading Roaming Users from the command line

(For advanced users only)

Note:

If you using Microsoft Vista, you must either run the DOS window as an Administrator or run an

elevated command prompt.

To launch an elevated command prompt in Vista, press the Win key, type cmd.exe, right click on

cmd.exe icon, and select Run as administrator.

1. Open a DOS window to get to the DOS Command Prompt.

2. From the DOS prompt, to run upgrade.exe from the location where the Dragon Medical SDK

Client Edition 10.5 is installed:
n Switch directories to the default location of upgrade.exe, C:\Program Files\

Nuance\NaturallySpeaking10\Program

n Enter this text on the command line:

upgrade.exe /silent <source-profiles-path> <destination-profiles-path>

The /silent option is required to upgrade users in batch mode. If you do not use the /silent

option, the update.exe GUI appears, and can extend how long it takes to process all profiles.

3. Copy the updated profiles to the path on the NMS Server machine that you set in the System

 Settings dialog box.

Steps for viewing the upgrade log
The upgrade.exe application included with the Dragon Medical SDK Client Edition Version 10.1

creates an upgrade log each time you run it. To open the directory containing the logs, click Start

> Dragon SDK Client Edition 10.1 > Show Dragon log.

Look for files named upgrade.mod and upgrdmod.log.

Converting local user profiles to DME
master user profiles

If you want to convert Dragon Medical (non-network) Version 10.0 local user profiles (stored only

on Dragon Medical Client workstations) to Dragon Medical Enterprise (where they would become

master user profiles on the network), you need to first convert them from local user profiles to

roaming user profiles in the earlier version of Dragon Medical.
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Note:  If your local user profiles are from Dragon Medical Version 8.x or 9.x, you must first upgrade those

user profiles to Dragon Medical Version 10.0 as instructed in your Dragon Version 10.0 doc-

umentation.

Before converting Dragon local user profiles
Caution:

Nuance recommends that you protect your profile data by taking these precautions:

n Before you convert them, back-up your Version 10.0 local user profiles.

n Plan to convert the Dragon Medical 10.0 local user profiles at a time when healthcare

providers are not using them to dictate, such as at night or on a weekend. If there

is no time when all your user profiles are not in use (because healthcare providers

dictate 24/7), you can convert sets of local user profiles from particular

workstations at appropriate times.

n Migrate user profiles to the location on the DME network only after you have

converted them on another machine.

n Note that once you convert these profiles, you will no longer be able to use them

with Version 10.0 of Dragon Medical. If you want to continue using Version 10.0

during a transition period, be sure you have backed them up to a separate location.

Overview of converting Dragon Medical 10.0 local
user profiles to roaming user profiles
To convert Dragon Medical Version 10.0 local user profiles to Dragon Medical Version 10.0 roaming

user profiles for use as DME master user profiles, on each workstation with users to migrate to

DME, you take these major steps:

1. If any single healthcare provider has multiple user names for logging in, that provider has more

than one profile. For efficiency, you should combine the multiple user profiles for one provider

to create a single user profile for that person.

2. Export the local user profiles to a different location, so that the action you take does not affect

the user profiles of dictating providers.

3. Enable the Roaming feature on the workstation and copy the user profiles to the roaming user

profile location.

4. Export a copy of each roaming user profile location and rename its top level directory of that

copy with a name that shows the files are for the new Dragon Medical Enterprise (DME)Network.

4. Create user accounts in NMS Server for the healthcare providers dictating with the local user pro-

files you are converting.

5. Associate the user accounts with the master user profiles for the corresponding healthcare pro-

fessionals.

6. Install the Dragon Medical Enterprise Client on the workstation.
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7. Log in to the Dragon Medical Enterprise Client with the NMS Server user account login and pass-

word.

Combining multiple Dragon Medical 10.1 profiles for
a single provider
Any healthcare provider who has more than one user name, has more than one user profile. If you

have any such providers, you need to reduce their profiles to a single user profile for using with

DME Network Edition. The single profile can have more than one vocabulary and more than one

audio input device (dictation source), so it is not any more restrictive than working with multiple

profiles.

To combine the multiple profiles, take these steps:

Export custom words from extra profiles
1. On the DragonBar, select Dragon > Manage Users.

2. In the list of user names, decide which profile you want to merge the others into for the pro-

vider. If you are not sure which profile to select, you should find out the one that the provider

most recently used and keep that profile. You can click the Properties button to find out the

date each profile was last saved.

3. Open one of the profiles you do not expect to keep. You see the vocabulary it uses.

4. Select Words > Export to export all custom words created with this profile. When the Export

Words dialog box opens, browse to the directory where you want to save the file and save the

words in a .txt file. You can name it whatever you would like—usually a name containing the

user name and the vocabulary helps identify the file. For example, you might name it Con-

radCardiology.txt.

Export commands from extra profiles
1. On the DragonBar, select Tools > Command Browser and open the Task Pane.

2. In the Task Pane, click Manage (underMode). You then see a list of command types appear

in the pane to the right.

3. Select all check boxes for all command types in the pane to the right.

4. In the Task Pane, click Export (underManage).

5. When the Export Commands dialog box opens, browse to the directory where you want to

save the file and save the custom commands as a .dat file using the same root name as you used

for the .txt file of words. For example, you might name the file ConradCardiology.dat.

Export vocabularies from extra profiles
1. If the provider has multiple vocabularies, go to the DragonBar and select Dragon > Manage

Vocabularies.... Select the vocabulary in the list and click the Export button to the right.

2. When the Save As dialog box opens, save the vocabulary in a .Top file using the same root

name as you used for the words and commands. For example, you might name it Con-

radCardiology.Top.
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Import commands into the profile you are retaining
1. Open the profile you are retaining and plan to upgrade to Dragon Medical Enterprise Network

 Edition.

2. On the DragonBar, select Tools > Command Browser.

3. Open the Task Pane and in the Task Pane click Manage (underMode).

4. In the Task Pane, click Import (underManage).

5. In the Import Commands dialog box, select the .dat file you saved earlier and click Open.

6. In the Import Commands dialog box, click Import.

7. If any of the commands would replace a command with the same name, you are prompted to

replace the existing command. Click No if you are uncertain whether or not to replace the com-

mand. Remember, the user profile you are keeping is the newest one, so probably has the new-

est command by the same name.

Import vocabulary into the profile you are retaining
1. If it is not already open, open the profile you are retaining and plan to upgrade to Dragon Medical

Enterprise Network Edition.

2. On the DragonBar, select Dragon > Manage Vocabularies... .

3. In theManage Vocabularies dialog box, click New and in the New Vocabulary dialog box,

name the vocabulary anthing you would like and choose a vocabulary to base it on from the pull

down list for Based on. Then click OK.

4. When the Vocabulary Optimizer dialog box appears, click Cancel. When theManage

 Vocabularies dialog box reappears, you see the additional vocabulary in the list.

Import words into the profile you are retaining
1. If it is not already open, open the profile you are retaining and plan to upgrade to Dragon Medical

Enterprise Network Edition.

2. On the DragonBar, select Words > Import.

3. When the Add Words from Word Lists Wizard appears, click Next.

4. Click Add Fileand when the Add File dialog box opens, select the file of words you exported

earlier and click Open.

5. Click Next to advance the wizard until you reach the end.

6. Click Finish to complete the process and close the wizard.

Exporting a local copy of local user profiles
Before you make the local user profiles into roaming user profiles (in the next section), you

should export a copy of those profiles to ensure that if anything goes wrong, you still have them.

To export the local user(s) from the workstation where Dragon Medical 10.0 is installed to a sep-

arate directory on the same machine or on a shared location on the network:

1. Create a temporary location for the 10.0 local user profiles (CpyLocProfiles).

2. Map a drive to the location for the 10.0 local user profiles (for example, Z:\CpyLocProfiles).

3. Start Dragon Medical Version 10.0.

4. On the DragonBar, select Dragon > Manage User.

130



Chapter 6: Upgrading roaming and local users to Dragon Medical Enterprise

5. When theManage Users dialog box appears, select the name of the user you want to make a

copy of and then select Advanced > Export.

6. Browse the repository where you are storing the copies of local profiles (Z:\CpyLocProfiles)

and click OK.

7. Repeat the above steps for each user profile you want to copy.

Enabling Roaming feature on workstation
To enable the Roaming feature and allow the software to copy local user profiles to the roaming

master user profile location, you take several steps on each workstation with local user profiles

you want to migrate to DME. You take these steps in the earlier version of Dragon Medical:

1. Create a directory on the computer to use as a Roaming User directory (for this set of instruc-

tions, let's call it RoamingProfiles).

2. Close any open user by selecting Dragon > Close user.

3. On the DragonBar, select Tools > Administrative settings.

4. On the Roaming tab, click Enable to enable under Roaming User to enable the feature.

5. UnderNetwork Directories, set a roaming user location that points to RoamingProfiles. This

location can be the same one for all workstations or distinct for each workstation.

6. Check the Allow non-roaming users to be opened option to enable it.

7. Close the Administrative settings dialog box.

8. On the DragonBar, select Dragon > Manage Users.

9. In theManage Users dialog box, select a user in the list and click Advanced > Save to roam-

ing.

When the Save To Roaming dialog box pops up, select the correct location name (should
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match the Display Name you entered on the Roaming tab earlier) and click OK. This action

saves that user profile to the roaming users directory you created.

10. Repeat the previous step for each user listed in theManage Users dialog box.

11. On the DragonBar, select Tools > Administrativesettings.

12. Disable Roaming User.

Migrating roaming users to DME master user
profiles
To migrate the roaming user profiles to the DME, where they become master user profiles:

On the Dragon Medical Client computer:
1. In MyComputer, map a network drive to the location for master user profiles on the Dragon

Medical Enterprise Network.

2. On the DragonBar, close any open user by selecting Dragon > Close user.

3. On the DragonBar, select Dragon > Mange Users...

4. When theManage Users dialog box opens, select a user name in the list and click Advanced

> Export....

5. Browse to mapped drive where the master user profiles for the Dragon Medical Enterprise Network

reside (or will reside) and select the folder that you want to export the user profile to.
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6. Click OK and wait for the export process to complete. When it completes, Dragon displays a

message indicating the export process was successful.

7. Repeat the previous three steps for each user in theManage Users list whose profile you want

to export.

On the NMS Server (through NMC Console):
1. Create user accounts in NMS Server for the healthcare providers who dictate with the local user

profiles you are converting. For more information on creating users, refer to Creating user accounts

for healthcare providers on page 117.

2. Associate the user accounts with the master user profiles for the corresponding healthcare pro-

fessionals. For more information, see Associating new user accounts with upgraded user profiles on page

134.

3. Install the Dragon Medical Enterprise Client on the workstation. For more information, see Down-

loading Dragon Medical Client MSI installer through NMC Console on page 142.

4. Log in to the Dragon Medical Enterprise Client with the NMS Server user account login and pass-

word. For more information, see Logging in to the NMS Server through the NMC Console on page 77
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Associating new user accounts with
upgraded user profiles

If you have not already done so, you should upgrade any roaming user profiles from Dragon Medical

Versions 8.x or 9.x before you proceed. If you have roaming user profiles from versions 10.0, you

need only copy those profiles to the new master user profiles location that you configured on the

NMS Server before you proceed. Then to allow healthcare providers to dictate with their newly

upgraded user profiles, you need to:

n In the NMC Console, create a Dragon Medical Enterprise user account for each healthcare provider

(refer to sections on configuring groups and user accounts in the Nuance Management Server

Administrator Guide for details).

n Associate that user account with the corresponding master user profile.

Associating user accounts with upgraded Dragon
roaming user profiles
To associate new user accounts with upgraded master user profiles:

1. Start the NMC Console and log in.

2. On the menu bar, click Utilities, and when the ribbon appears, click the User Profile Asso-

ciation icon. The User Profile Association tab opens, displaying a list labeled User Accounts

to the left and another list labeled Existing Profiles to the right. (Under Existing Profiles you

see only Version 10 or 10.1 profiles you have upgraded using the Dragon User Upgrade tool,

but not yet associated with aNetwork Edition user account.)
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3. If you do not see the user accounts you are looking for in the Users Accounts list or the pro-

files you are looking for in the Existing Profiles list, click the Scan folders now button and

wait a few minutes for the lists to update.

4. Click the login for the user account in the User Accounts list, then click the corresponding

user profile in the Existing Profiles list, and click the Associate button to tie the profile to

that user account.

The user account and associated user profile appear in the Associations list in the lower por-

tion of the page.
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5. Repeat the above steps until all healthcare provider user accounts have been associated with

their profiles.

6. If you make a mistake, you can select a user account in the Associations list and click the

Remove button. The user account and user profile return to the two lists above and you can

associate them with a different user account or user profile.

7. Click Finish to save changes you made in the User Profile Association tool.

8. To exit the tool without saving your changes, click Close without clicking Finish first.
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Overview of installing Dragon Medical
Client

Caution:

If you have local user profiles that you want to upgrade from an earlier version of Dragon Medical,

you must use that older version of Dragon Medical to convert the local user profiles to roaming user

profiles before you upgrade your software. Be sure you have converted those user profiles before

you remove the already existing installation of Dragon Medical. For instructions on how to convert

them, refer to Converting local user profiles to DME master user profiles on page 127.

Caution:

The account that each Dragon Medical Client workstation runs under must have full

read/write/modify access to the master user profiles directory so that Dragon can create and mod-

ify the master user profile for each healthcare provider.

When you install the Dragon Medical Enterprise Network Edition Client Software, you usually perform a

typical Dragon installation. You usually do not set administrative options, formatting options, user

options, or other options when you install Dragon Medical Client. This applies whether you install

the Dragon client through the Nuance Management Console or outside of the console. As an admin-

istrator, you set almost all of those options through the NMC Console after you install Dragon. So,

you do not have to set most options or Dragon settings during your custom MSI installation of

Dragon.

However, if you want to set up Dragon so that the DragonBar always comes up in, for instance,

Floating mode on every single client workstation in your network, you can still set some options

in advance of the installation by using the Dragon Medical SDK Client, available on the Nuance Man-

agement Server Software and Documentation DVD. After you set the options, you can retrieve the nsde-

faults.ini file and pass it as an argument tomsiexec.exe (the MSI installer from Microsoft) on

the command line by following the instructions in Installing multiple clients with same default options

using MSI on page 168.

Note:

The NMC Console includes an icon that opens a dialog box where you can download a Dragon Med-

ical Client MSI installation file. This installer automatically downloads the Dragon Medical Enterprise

vSync for EHRs feature if the Citrix client is installed on the computer. This feature is required to

use Dragon Medical Client with a published application in a Citrix environment. For more infor-

mation, refer to the Administration Guide for Dragon in a Citrix environment.
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Opening ports to access user profiles on web
server or secure web server
Caution:

It is critical that if they are not already open, you open the ports required for the Dragon Medical

Client to access the master user profiles on a web server or secure web server.

To allow the Dragon Medical Client to access master user profiles on a web server (http) that is not

SSL, open port 80.

To allow the Dragon Medical Client to access master user profiles on a secure (SSL) server (https),

open port 443.

Approaches to installing the Dragon Medical Client
You can install the Dragon Medical Client in any of these ways:

n Downloading Dragon Medical Client MSI installer through NMC Console on page 142

n Installing Dragon client manually outside of NMC Console on page 145

n Pushing Dragon MSI installation to multiple workstations on page 151

l Carrying out administrative installation of Dragon with .bat file on page 154

l Creating custom installer for installing client in Active Directory on page 161

n Installing multiple clients with same default options using MSI on page 168
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System Requirements for installing
Dragon Medical Clients

Hardware requirements
Processor: Intel Pentium4 or later or AMD Athlon 64 1 GHz or faster/later processor.

Recommended: 2.4 GHz processor or greater. Faster processors produce faster performance.

RAM: 512 MB of RAM for Windows XP, 1 GB RAM for Windows Vista, 2 GB RAM

for Windows 7, 32-bit and 64-bit. Recommended: 4 GB RAM for Windows 7, 64-bit.

Cache: 512 KB minimum L2 Cache. Recommended: 1 MB L2 Cache.

Hard disk space: 2 GB. Recommended: 2.5 GB.

Sound card: Sound card capable of recording, set to 16 bit 11 KHz for audio recording,

if any provider will dictate with a microphone plugged in to the Mic-in jack of the workstation.

USB port: If any provider will dictate with a USB microphone, such as a Nuance PowerMic II.

Speakers: For playback of recorded speech and Text-to-speech features.

Network: An Internet connection for working with the Nuance Management Server.

Audio dictation source devices
Bluetooth (Optional): For Bluetooth wireless microphone support, visit http://-

support.nuance.com/compatibility/.

Microphone: Nuance-approved noise-canceling headset microphone.

For a complete listing of Dragon-compatible audio input devices, visit the Hardware Com-

patibility List on the Dragon Support Web pages at http://support.nuance.com/compatibility/.

Dragon Medical Enterprise Network Edition has built-in support for the Nuance PowerMics:

n PowerMic (beige)—Only newer beige PowerMics work with Dragon Medical Clients on

Windows Vista.

n PowerMic II (black)—PowerMic II packaging should display Vista compliance labeling. If you

are unsure about the compatibility, confirm that the firmware version is v2.02 or higher. Refer

to https://isupport.nuance.com/OA_HTML/csksxvm.jsp?nSetNumber=13102.
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Software requirements
Operating systems:

32-bit operating systems:Windows XP Home or Windows XP Professional

with Service Pack 3, Windows Vista Home or Professional Service Pack 2,

or Windows 7.

64-bit operating systems:Windows Vista Home or Professional, Windows Vista

with Service Pack 2, Windows Server 2008, or Windows 7.

Note:Windows XP 64-bit is not supported.

Citrix software:

The Citrix Program Neighborhood, Version 10.2 or Version 11, the Citrix Program

Neighborhood Agent, Version 10.2 or Version 11, or the Citrix Web Client, version

10.2 or version 11. Applies only if your installation uses vSync.

Note:

If you have set up your network to work with Citrix, you should also refer to the

Dragon in a Citrix Environment Administrator Guide, provided in PDF format.

Internet Browser:

Microsoft® Internet Explorer 6 or higher (free download available at

http://www.microsoft.com).
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Downloading Dragon Medical Client
MSI installer through NMC Console

After you create your own MSI installer for Dragon Medical Client, from any workstation on the net-

work where you have installed the appropriate certificates, you can access the NMC Console, then

download the Dragon Medical Client MSI installer through the console for installation on that work-

station:

1. Be sure that the computer you are installing the Dragon client on meets the system requirements

for installing and running Dragon. See System Requirements for installing Dragon Medical Clients on

page 140.

2. Log in to the computer as a Windows administrator.

3. On the workstation where you are installing Dragon, be sure that you install the Nuance cer-

tificates (see Installing Nuance certificates on page 74).

4. On the workstation where you are installing Dragon, open Internet Explorer and enter the URL

 to access the NMC Console (see Logging in to the NMS Server through the NMC Console on page

77).

5. Once the client GUI displays its login page, log in.

Setting the location of the MSI installer
If this is the first time you have attempted to download the MSI installer from the NMS Server, be

sure you have entered the location of the MSI file on the server into the system settings on your

NMS Server:

1. In the NMC Console, click the Nuance icon

and a menu drops down.

2. Select System settings from the menu.

3. In the System Settings dialog box, click on Dragon to expand the Dragon settings.
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4. Set the Dragon client installation URL to the full path to the location where you placed your

custom DragonMSI installer, a file with an .msi extension, on the NMS Server machine. You

need only set this path the first time you are downloading the installation files through the

NMC Console

5. Click the Save button at the dialog box to save the change and exit the System Settings dialog

box.

Downloading the MSI installer to the workstation
After you have entered the location of the MSI installer in the system settings on the NMS Server,

you are ready to download the MSI installer to the workstation:

1. In the NMC Console, click the Utilities tab.

2. Click the Dragon Install icon

and aDragon Installations tab opens.
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3. Click the checkboxes for the Dragon client installation link and for any manuals you'd like to

install on the client.

4. Click on the magnifying glass in the Download to text box, browse to the path where you want

the files downloaded, and click the Download button. The server immediately downloads the

software to the workstation.

5. Proceed to the directory on the workstation where you downloaded the .msi installation file.

6. DInstalling Dragon client manually outside of NMC Console on page 145.

7. For details on proceeding through the Dragon Medical Client installation wizard, refer to Install-

ing Dragon client manually outside of NMC Console on page 145.
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Installing Dragon client manually
outside of NMC Console

Be sure your computer meets the system requirements for installing and running Dragon Medical.

For additional steps you might need to take if you are upgrading, see Preparing to upgrade Dragon Med-

ical Clients to Network Edition on page 114.

1. Insert the Dragon Medical Enterprise Network Edition Client Software installation DVD into the

DVD drive of the computer. If the installation does not start on its own, browse on the DVD

for the setup.exe file and double click it.

2. If you are installing the client on Windows XP and have SP2 but not SP3, you can still install

Dragon Medical if you execute setup.exe from the command line using some options outlined in

Installing Dragon client manually outside of NMC Console on page 145.

3. The InstallShield window might display and ask you to install software that Dragon Medical

requires on the computer. The software might include Microsoft .NET Framework 3.5 SP1 and

Visual C++ 9.0 Runtime for Dragon. Click Install.

4. If a message displays asking you to restart your computer, restart the workstation and follow the

instructions.

5. On the Welcome page, click Next.

6. On the License Agreement page, read the license agreement information. Select I accept the

terms in the license agreement and click Next.
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7. On the Customer Information page, type your name, the name of your organization and the

serial number from Nuance, then click Next.

8. On the Setup Type page, select Typical/Complete. Click Next.
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9. On the Ready to Install the Program page, click Install.The installation process begins to

copy files to your computer.
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10. When the wizard displays InstallShield Wizard Completed, click Finish.

Now, proceed to the next section to ensure that the client can find its NMS Server.
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Ensuring Dragon Medical Clients can
find Nuance Management Server

After you have completed installation of the Dragon Medical Client on multiple workstations, when

a healthcare provider logs in to the client, that provider indicates the particular machine where the

server is running:

1. When the healthcare provider logs in to the Dragon Medical Client, first the splash screen displays

(shown below):

2. When the Dragon Login dialog box appears, the provider should click the Advanced button:
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3. When the Server Location dialog box appears, the provider must then enter the name of the

machine that houses the Nuance Management Server:

For information on using the check boxes in this dialog box, refer to the Dragon Medical Client

Help.

4. The provider then logs in using the user account that anNMS Administrator has created in

the Nuance Management Server:

5. If this is the very first time the provider has ever logged in to the Dragon Medical Client (the user

has no previously existing profile of his or her voice), the New User Wizard appears.The New

User Wizard does not appear if the provider has a user profile you upgraded from an earlier ver-

sion of Dragon Medical.

6. The provider should click the check box indicating I have read and agree to the License

 Agreement and proceed through the New User Wizard as instructed.

7. When the provider finishes completing every page of the wizard, the DragonBar then becomes

available, and the provider can begin dictating.

For more information on using the Dragon Medical Client, refer to the Dragon Help.
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Pushing Dragon MSI installation to
multiple workstations

The Dragon Medical Enterprise Network Edition Client Software DVD includes a Microsoft Windows

Installer (MSI) file. You can use this MSI file to install Dragon from a server to client workstations

across a network or to install several client workstations at once using either an SMS or SCCM

installation or an Active Directory Services installation.

An overview of the options for installing multiple Dragon Medical Client workstations at once is pro-

vided below.

Caution:

Whenever you carry out an MSI installation of Dragon Medical Client for Dragon Medical Enterprise

Network Edition, Nuance recommends that you include the /x option in the command line that

executes msiexec.exe or Dragon's setup.exe file. The /x option tells the installer to uninstall any

Dragon Medical software already on the machine before it proceeds to install the new client soft-

ware. For more information on command line options you can use to install Dragon, refer to Under-

standing Dragon MSI command line options on page 157.

Note:

When you create an MSI installer for the Dragon Medical Client included with the NMS Server, you

are not required to have the installer set any user or administrative options that you would prefer

to set in the Nuance Management Server later. However, if you would like to set the same Dragon

options on all workstations, you can pre-set them as outlined in Installing multiple clients with same

default options using MSI on page 168.

The Dragon Medical Client installation DVD contains a Dragon .MSI file named Dragon

 NaturallySpeaking 10.msi for installing the client.

On the Nuance Management Server Software and Documentation DVD, you find an .MSI file for the

Dragon SDK Client Edition of the product that you install for all Profile Optimizer Speech Nodes. Look

in the Dragon Medical SDK Client subdirectory of the DVD for the installer.

A list of all .MSI files you need to know about follows:

DVD name MSI file name

Dragon Medical Enterprise Network Edition Client
Software DVD

Dragon NaturallySpeaking 10.msi

Nuance Management Server Software
and Documentation DVD

Dragon SDK Client Edition 10.msi
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The command line you use to install Dragon using the .MSI file is:

msiexec.exe /i "Dragon NaturallySpeaking 10.msi"

For information on installing Dragon Medical Client using this .MSI file, please refer to the

following tables of options under Carrying out administrative installation of Dragon with .bat file on page

154:

n General options for installing Dragon

n MSI options for installing Dragon features/advanced options

n Feature variables to set through the ADDLOCAL or ADVERTISE properties

Options for pushing MSI installation of Dragon to
one or more workstations on a network
You can use a server application to push an MSI installation of Dragon to client workstations with-

out having to install Dragon separately on each computer. The server administrator creates an

image of the Dragon installation program. The administrator then places the image on a server and

configures the server to automatically push the application to client workstations.

There are several server applications that you can use to push a Dragon installation:

n Windows Server 2008

n Windows Server 2003

n System Center Configuration Manager (SCCM)

n Active Directory Services

Support for the Windows System Center
Configuration Manager
You can use the System Center Configuration Manager (SCCM) to push an MSI installation of

Dragon Medical Client across a network to multiple client workstations at once. SCCM provides a

mechahism for pushing the Dragon Medical Client installation from a server to several client work-

stations, using a Windows Installer (MSI) file to push the installation to workstations that run a

compatible Windows operating system, including Windows XP, Vista, and Windows 7.

For information about Windows Installer technology, you can download the article Software Dis-

tribution in Configuration Manager, available at this link: http://technet.microsoft.com/en-us/li-

brary/bb632640.aspx

Support for the Windows System Management
Server
You can use the System Management Server (SMS) to push an MSI installation of Dragon Medical

Client across a network to multiple client workstations at once. SMS provides a mechahism for
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pushing the Dragon Medical Client installation from a server to several client workstations, using a

Windows Installer (MSI) file to push the installation to workstations that run a compatible Win-

dows operating system, including Windows XP, Vista, and Windows 7.

For information about Windows Installer technology, you can download the article Scenarios and

Procedures for Systems Management Server 2003: Planning and Deployment available at this link:

http://www.microsoft.com/downloads/details.aspx?FamilyId=E0644BB4-2336-4254-8A18-

9BC180713F7E&displaylang=en.

Support for Windows Server with Active Directory
Services
You can use Windows Active Directory Service to push an MSI installation of Dragon across a net-

work to multiple client workstations at once.

Active Directory Services is a feature of Windows Server 2008 or 2003. The Group Policy com-

ponent of Active Directory Services includes a Software Installation snap-in that lets an admin-

istrator create a network installation. Administrators can use this feature to install Dragon Medical

Client to workstation computers that run Windows XP or Windows Vista.

Dragon supports the Active Directory Services Assign to Computers installation option. This

option requires that you reboot the computer to complete a Dragon Medical Client installation.

You can delay the installation of Dragon Medical Client on a workstation that runs Windows XP or

Vista by enabling logon optimization for group policy. You can view a log entry for this type of

installation in the event log after the client computer reboots for the first time. The Dragon instal-

lation application then installs Dragon and reboots the computer for a second time. The installation

is a silent installation and does not display a GUI.

1. If necessary, create a custom MSI installation of Dragon Medical Client to push to several client

workstations.

2. Verify that each computer meets the system requirements for Dragon Medical Client installation.

See System Requirements for installing Dragon Medical Clients on page 140 for more information.

3. Push the custom MSI installation of Dragon to the client workstations.
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Carrying out administrative
installation of Dragon with .bat file

A straightforward way to install Dragon Medical Client from the command line to a server is to carry

out an administrative installation using a .bat file.

Caution:

Only advanced users should attempt any type of administrative installation.

Note:

A script for carrying out a full administrative installation, including installation of Visual C++ Run-

time for Dragon, is provided in the admininstall.bat file under the top of the directory structure

on the Dragon Medical Enterprise Network Edition Client Software DVD. The script provided includes

a bare minimum of the options available, so you might want to read through the sections on

Dragon Medical Client command line installations to learn about other options you might use.

Running the batch file
The admininstall.bat file is a batch file that uncompresses setup files into a network location for

installation using SMS or another service. Since the workstation you are installing Dragon Medical

Client on could be a 32-bit or a 64-bit machine, the batch file chooses the appropriate vcruntime

executable to run based on the type of system it finds.

To run the batch file, you enter admininstall.bat and follow it with three arguments, in the order

listed below:

n Full path to the vcruntime source file for 32-bit systems.

n Full path to the vcruntime source file for 64-bit systems.

n Full path to the Dragon NaturallySpeaking10.msi file.

The script needs both 32-bit and 64-bit vcruntime files available to run.

You can run this admininstall.bat file as is or modify it using alternative MSI options available

for Dragon.

Understanding the script in admininstall.bat
Below are some of the lines from the script in the admininstall.bat file provided with the Dragon

Medical Client.
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Near the top of the batch file, you see lines that first check the parameters entered and, if the

parameters passed are not acceptable, execute a routine that handles that situation:

:rem //Check and analyze input parameters if .%1.==.. goto bad_arg if

.%2.==.. goto bad_args if .%3.==.. goto bad_args

If the arguments you pass when you enter the command are acceptable, the batch file sets the

NETWORK_VCRUNTIME_DIR variable to the first argument, the NETWORK_VCRUN-

TIME_X64_DIR variable to the second, and the NETWORK_DNS_DIR variable to the third:

set NETWORK_VCRUNTIME_DIR=%1%

set NETWORK_VCRUNTIME_X64_DIR=%2%

set NETWORK_DNS_DIR=%3%

Of the two VCRUNTIME variables, the first is for the executable for 32-bit systems and the sec-

ond for 64-bit systems.

In the next section of the batch file you see the lines that install Visual C++ Runtime for Dragon,

which it must install before it can install Dragon. The batch file first installs 32-bit machine vcrun-

time and displays messages as it progresses:

echo Installing Visual C++ Runtime for Dragon NaturallySpeaking...

To install Visual C++ Runtime for Dragon, the script uses the full path to vcruntime.exe and

passes it several options:

/a to indicate it is an administrative installation (to a server)

/L option followed by the language ID (1033 for English)

/v option followed by a series of MSI installation options all enclosed in quotation marks, includ-

ing:

n TARGETDIR to indicate where to put the image resulting from an administrative installation

n /qb to display only a basic GUI

n /L to indicate the types of messages to log and the file to log them to

Here are the lines in the script:

ISSetupPrerequisites\VCRuntime\vcruntime.exe /a /l1033

/v"TARGETDIR=%NETWORK_VCRUNTIME_DIR% /qb /Liwmo!e+

%TEMP%\admininstall.log"

Note:

An administrative installation should always use the TARGETDIR option instead of the

INSTALLDIR option.
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The batch file then installs 64-bit vcruntime using the full path to vcruntime_x64.exe and passes

it the same options:

echo Installing Visual C++ Runtime for Dragon NaturallySpeaking 64bit

(x64)...

ISSetupPrerequisites\VCRuntime\vcruntime_x64.exe /a /l1033

/v"TARGETDIR=%NETWORK_VCRUNTIME_X64_DIR% /qb /Liwmo!e+

%TEMP%\admininstall.log"

If you have only the 32-bit version of Dragon Medical Client, you need to use a different file:

ISSetupPrerequisites\VCRuntime\vcruntime.exe /a /l1033

/v"TARGETDIR=%NETWORK_VCRUNTIME_DIR% /qb /Liwmo!e+

%TEMP%\admininstall.log"

If the installation of Visual C++ Runtime succeeds or fails, the batch file displays the appropriate

message.

Finally, the log file installs Dragon Medical Client, using a single line of code that calls the

setup.exe command and passes it:

n /a option for administrative install

n /s option for a silent no-GUI installation

n /v option to indicate msiexec options follow, enclosed in quotation marks

The msiexec options with /v include /qb for display of a basic GUI during the process, the

TARGETDIR setting, and a /L with a series of log file options, including the name and location

for the log file:

echo Installing Dragon NaturallySpeaking...

setup.exe /a /s /v"/qb TARGETDIR=%NETWORK_DNS_DIR% /Liwmo!e+ %TEMP%-

\admininstall.log"

Whether the installation of Dragon succeeds or fails, the batch file displays an appropriate message.

The remainder of the file processes errors and handles any bad arguments passed on the command

line.

You can modify this file using any of the options and feature variables presented in the three

tables in the section that follows:

n General options for installing Dragon

n MSI options for Installing Dragon features/advanced options

n Feature variables to set through the ADDLOCAL or ADVERTISE properties

For more information on these options, proceeed to Understanding Dragon MSI command line options

on page 157.
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Understanding Dragon MSI command
line options

Modifying the admininstall.bat file
To make changes to the admininstall.bat file, you can use any of the options below:

General options for installing Dragon

Options Description

SERIALNUMBER=abcde-fgh-ijkl-mnop-
qr

The serial number for the Dragon product. AllDragon instal-
lations require that you provide a serial (license) number for
the product. The Dragon installation process checks for a
serial number even if you run the process from a command
line.

NAS_ADDRESS="DNS|<IP_address>" Indicates the IP address of the NMS Server that the Dragon
Medical Client connects to when the healthcare provider logs
on. If you set this option during the installation, then the
user does not need to enter the server machine name when
logging in toDragon Medical Client for the first time. If you do
not set this option during the installation, each provider
should click the Advanced button when logging in to the
client for the first time and enter either the IP address or the
machine name (with no prefix for instance, nowww or
http://) in the Server Location text box.

QUICKSTART=0 (or 1) Set the default state of Enable QuickStart Mode to enable
QuickStart and to create a shortcut for Dragon in the Win-
dows Startup folder.

Set the option to 0 so Dragon does not start when Windows
starts.

Set the option to 1 to set Dragon to start when Windows
starts.
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MSI options for installing Dragon features/advanced options

Options Description

ADDLOCAL=Feature1,Feature2,... or ADD-
LOCAL=ALL

Set the ADDLOCAL option to a comma delimited list of features
to install locally. To install all features locally (including speech
files), set the ADDLOCAL option toALL.

See General Options for Installing Dragon for a list of the fea-
tures that you can make available or install locally using the
ADDLOCAL option or the ADVERTISE option.

ADVERTISE=Feature1,Feature2,Feature3,... Set the ADVERTISE option to a comma delimited list of features
to make available but not install locally. To install all features as
advertised, set the ADVERTISE option toALL.

The ADVERTISE option overrides the ADDLOCAL option. The
best method for installing a particular set of features is to set
the ADDLOCAL option toALL and then set the ADVERTISE
option to the features you do not want to install locally.

See General Options for Installing Dragon for a list of the fea-
tures that you can make available or install locally using the
ADDLOCAL option or the ADVERTISE option.

REINSTALL=Feature1,Feature2,... (or ALL) Set the REINSTALL option to a comma delimited list of features
to reinstall. To reinstall all features, set the REINSTALL option
toALL.

If you set the REINSTALL option, you should also set the REIN-
STALLMODE option to set the type of reinstall to perform. If you
do not set the REINSTALLMODE option, the installation process
only reinstalls a file if it is an earlier version of the file that is
presently installed or if the a file is not present on the system.
By default, no registry entries are rewritten.

Even if you set the REINSTALL option toALL, the installation
process only reinstalls features that are already installed. Thus,
if you use the REINSTALL option for a product that is not yet to
installed, product installation does not occur.

For more information, see: http://msd-
n.microsoft.com/library/default.asp?url=/library/en-
us/msi/setup/reinstall.asp

REINSTALLMODE={type of reinstallation to
perform}

Set the REINSTALLMODE option to a string that indicates the
type of reinstall to perform. Options are case-insensitive and
order-independent.
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You should use this option when you use the REINSTALL
option. You can also use this option during an installation of
Dragon Medical Client, not just during a reinstallation.

Opt Purpose

p Only reinstall a file if the file is missing.

o Only reinstall a file if the file is missing or is an older
version.

e Only reinstall a file if the file is missing or is an equal
or older version.

d Only reinstall a file if the file is missing or a different
version is present.

c Only reinstall a file or files whose checksums are miss-
ing or corrupt.

a Force a reinstall of all files, regardless of checksum or
version.

u Rewrite all required registry entries from the Registry
Table that go under HKEY_CURRENT_USER or
HKEY_USERS.

m Rewrite all required registry entries from the Registry
Table that go under HKEY_LOCAL_MACHINE or
HKEY_CLASSES_ROOT. Regardless of machine or
user assignment.

Rewrite all data from the following tables: Class,
Verb, PublishComponent, ProgID, MIME, Icon, Exten-
sion, and AppID .

Reinstall all qualified components. When reinstalling
an application, run the RegisterTypeLibraries and
InstallODBC actions.

s Reinstall all shortcuts and re-cache all icons, over-
writing existing shortcuts and icons.

v Run from the source package, re-cache the local pack-
age. Does not apply to a new installation of a product
or feature.

REMOVEOLDPROD=1 Set the REMOVEOLDPROD option to remove an older version of
Dragon before installing the newer version. You should on only
use this option for major upgrades.

/x<Product.msi|ProductCode> Set the installation process to uninstall the current installed ver-
sion of Dragon. You must perform this action during an
upgrade. However, you should be familiar with the entire
upgrade procedure before you use this option.
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Feature variables to set through the ADDLOCAL or ADVERTISE
 properties

Feature/Sub-feature Sub-feature

NatSpeak
Note: Required in ADDLOCAL;
if not included, installation fails

None

Samples (Sample Com-
mands files)

None

TTS (Text-to-Speech) TTSENU (US English Text-to-Speech)
TTSENG (British English Text-to-Speech)

Tutorial TutENX (English Tutorial)

Speech ENX (English)
/ENU (US English)

Dragon NaturallySpeaking
and Dragon Medical:Sub-fea-
tures for ENU (US English):
ENULegal (US English Legal
Large)
ENUGeneral (US English General
Medium, US English Empty Dic-
tation, US English Commands
Only)
ENUGenSvc (US English Large
General)

Note: The ENU sub-feature includes
support for the following accents:

General: Use if your accent is not
covered by the another choice or
you are not sure which to select.

Australian accented English

British accented English

Indian accented English

Inland Northern US (Great Lakes
area): Covers Upstate New York
through the Chicago area.

SEAsian accented English: South
East Asian

Southern US: Covers most of the
Southern United States, including
Texas.

Spanish Accented English

Speech ENX (English)
/ENU (US English)
(continued)

Dragon Medical Only Sub-fea-
tures for ENU
(US English):
ENUCardiology (US English
 Medical Large Cardiology, Pedi-
atric Cardiology)
ENUEmergency (US English
Emergency Medicine Large)
ENUGastroenterology (US Eng-
lish Medical Large Gas-
troenterology, Pediatric
Gastroenterology)
ENUGeneralPractice (US English
Large Family Medicine, Allergy

ENUObGyn (US English Medical
Large ENT, Fetal Medicine, Mid-
wifery, Obstetrics and Gynecology,
Ophthalmology)
ENUOncology (US English Medical
Large Oncology, Radiation Therapy)
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and Immunology, Dermatology,
Epidemiology, Geriatric, Hema-
tology, Infectious Disease, Inter-
nal Medicine, Medical Education
andWriting, Nephrology,
 Nursing, Osteopathy, Pulmonary
Disease, Rheumatology, Sleep
Lab)
ENUMedical (US English General
Medical Large No Specialty)
ENUMentalHealth (US English
Large Medical Addiction Psy-
chiatry; Endocrinology, Diabetes,
andMetabolism; Psychiatry, Psy-
chology)
ENGNeurology (US English Anes-
thesiology, Neurology, Pain Med-
icine, Physical Medicine and
Rehabilitation, Vascular and Inter-
ventional Radiology)

ENUOrthopaedic (US English Medical
Large Dentistry, Large Hand Sur-
gery, Neurosurgery, Orthopaedics,
Oral and Facial Surgery, Orthopaedic
Surgery, Plastic Surgery, Podiatry)
ENUPathology (US English Medical
Large Pathology)
ENUPediatrics (US English Medical
Large Pediatrics, Neonatal and Peri-
natal Medicine, Pediatric Dentistry)
ENURadiology (US English Medical
Large Nuclear Medicine or
Radiology)
ENURehabilitation (Neurology, Phys-
ical Medicine, Rehabilitation and
Speech and Language Pathology)
ENUSurgery (US English Medical
Large Cardiac Surgery, Colon and
Rectal Surgery, Surgery, Thoracic
Surgery, Urology, Vascular Surgery)

Creating custom installer for
installing client in Active Directory

If you are installing Dragon on a network using Active Directory Services, you can create a cus-

tom installation program using a set of tools available from Microsoft.

n Download and install the tools

n Run the wizard

You are then ready to use the custom installer to install the Dragon Medical Client from Active

Directory Services.

Installing the Microsoft Custom Installation Wizard
The Microsoft Custom Installation Wizard is part of the Microsoft Office Resource Kit Tools. To

install the Custom Installation Wizard:

1. Download the Office Resource Kit Tools (OrkTools.exe) from: http://ww-

w.microsoft.com/office/orkarchive/xpddl.htm. The OrkTools.exe self-extracting executable

(EXE) file installs the core Office XP Resource Kit tools on your computer through a single

Setup program.

2. After downloading OrkTools.exe, to install the tools, you either double-click the executable or

select Start > Programs > Microsoft Office Tools > Microsoft Office XP Resource Kit

Tools.

After you install the tool, you use its Custom Installation Wizard to create your custom instal-

lation. For details on using the wizard, continue with the next subsection.
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Modifying setup Properties for Custom Installation
The following explains how to modify setup properties for a custom installation of Dragon Medical

Client. This example shows how to add to the installer configuration one of the many MSI options

you can set for installing Dragon Medical Client, the SERIALNUMBER property. (You can add any

options available to MSI on the command line.)

1. Start the Microsoft Custom Installation Wizard by choosing Start > Programs > Microsoft

Office Tools > Microsoft Office XP Resource Kit Tools, and then click Custom Instal-

lation Wizard. The Custom Installation Wizard screen displays:

2. Click Next.

3. On the Open the MSI File page of the wizard, shown below, select the .MSI file you want to

use to create a custom installation. The compiled .MSI file is located on your installation CD.

The file you should select is named Dragon Medical: Dragon NaturallySpeaking 10.msi.

4. Click Next.
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5. Click Yes when you see the following message:

6. On the Open the MST File page of the wizard, select Create a new MST file.

7. Click Next to continue.

8. On the Select MST File to Save page of the wizard, select a file name and path for the MST

file you are creating:

9. Click Next.
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10. On the Specify a Default Path and Organization page, select the default path for the instal-

lation. By default, Dragon Medical Client installs in \Program Files\

Nuance\NaturallySpeaking10.

11. Click Next.

12. On the Remove Previous Versions page, keep the default selections and click Next. This

page applies only to Microsoft Office and does not affect the Dragon Medical Client installation.

13. Click Next to keep all the defaults when you come to the Set Features Installation States

page, where you select particular components to install. The illustration here shows some of the

Medical vocabularies you might choose:
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14. On the next several pages of the wizard, click Next on each, and proceed until you reach the

Modify Setup Properties page. All the pages in between apply only to Microsoft Office or do

not affect the Dragon Medical Client installation.

Customize Default Application Settings page

Change Office User Settings page

Add/Remove Files page

Add/Remove Registry Entries page

Add, Modify, or Remove Shortcuts page

Identify Additional Servers page

Specify Office Security Settings page

Add Installations and Run Programs page
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15. Use theModify Setup Properties page, shown below, to add, modify, and set the MSI options

of your custom installation.

16. Click the Add... button to display the Add/Modify Property Value dialog box, where you

modify the MSI installation options. In this example, we add and set the SERIALNUMBER

option.

17. In the following Add/Modify Property Value page, enter the new property name SERI-

ALNUMBER and a valid serial number, then click OK:
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18. Note that theModify Setup Properties page re-displays with the updated information. For

example:

19. Continue adding or modifying other MSI options that apply for your environment. Once you are

done, click Next.

20. On the Save Changes page, click Finish.

21. When the Custom Installation Wizard page appears, click Exit. This screen displays the loca-

tion ofWindows Installer transform (.MST file) that you created.

After you save changes, you can use the resulting .MST file to manage an installation through a

Group Policy in Active Directory Services.

You are now ready to use the custom installer you created to install the product.
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Installing multiple clients with same
default options using MSI

If would like to set the same default options for a several Dragon Medical Client workstations, you

can preconfigure them using a natspeak option of the Dragon Medical SDK Client on the command

line and then apply those settings by passing the .ini file the SDK creates to the MSI installer on

the command line.

You must take the actions outlined in the subsections that follow on a machine where you have

installed the Dragon Medical SDK Client. (It is required on every Profile Optimizer Speech Node.) If you

have not yet installed the SDK, refer to Installing prerequisite softwarefor Profile Optimizer Server on

page 53

Setting default Client options on command line
before installing
After you install the Dragon Medical SDK Client on any Profile Optimizer Speech Node machine, you

can take advantage of a natspeak command line option available only in the SDK.

You use the Dragon Medical SDK Clientnatspeak command to pre-configure default settings for

one workstations, then later have those defaults automatically apply to multiple Dragon Medical

Clients you install using an MSI installation. When you use the natspeak command, you no longer

have to set these options on each individual Dragon Medical Client workstation.

On any Profile Optimizer speech Node machine, take the following steps to set the options you want

to pre-set on multiple Dragon Medical Clients through an MSI installation:

1. Open a command prompt and switch directories to the following path:

<drive>:\Program Files\Nuance\Dragon SDK Client Edition10\Program

2. Enter the command line shown below, passing /SetDefaultOptions:

natspeak.exe /SetDefaultOptions

3. In a moment, the Options dialog box appears.

Here you set the options you'd like each client workstation to use.

You set the options under the several tabs you see. For instance, the next illustration shows the

View tab with displayMode for Dragon set to Floating and the Results Box set to anchor

itself to the application and hide after 5 seconds.
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4. For more information on setting the options in the tabs of the Options dialog box, refer to the

Dragon Medical Client Help.

5. When you have finished setting all of the options the way you want them, click OK to close the

dialog box. Dragon has saved the configuration you created with the natspeak.exe command in

the nsdefaults.inifile. You can find this .ini file under

C:\Program Data\All Users\Application Data\Nuance\Dragon SDK Client

Edition10\ on a Windows Server 2008 machine and under

C:\Documents and Settings\All Users\Application Data\Nuance\Dragon SDK Client

Edition10\ on all other Windows operating systems.

6. Retrieve the nsdefaults.ini file and copy it to a directory where all workstations you plan to

install the Dragon Medical Client on can access it.
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Installing Visual C++ Runtime on the client
Before you use the nsdefaults.ini file you just created in an MSI installation of Dragon Medical

Client, you need to install Visual C++ Runtime:

1. Go to the machine you plan to carry out the MSI installation from and copy the files from the

Dragon Medical Enterprise Network Edition Client Software DVD to a location on your network that

you can access all client workstations from.

2. Open a command prompt and switch to the \ISSetupPrerequisites\VCRuntime\ directory

inside the directory where you copied the Dragon Medical Client files.

3. Install Visual C++ on the command line by entering one of the commands below; use the first

on a 32-bit machine and the second on a 64-bit machine:

vcruntime.exe /S /v"/qn /l*v vcruntime.log"

vcruntime_x64.exe /S /v"/qn /l*v vcruntime_x64.log"

The /S is the silent option for vcruntime, to turn off its GUI during the installation. The /v

option introduces a series of any msiexec.exe options, all enclosed in quotation marks after the

/v, with no space allowed between the /v and the opening quotation mark. You should include

the /l option for /v followed by the full path to an error log file, so that if something goes wrong

during the installation, you receive messages about it. Options for /l are listed in the table below.

Suboptions for the /L MSI installation option

Suboption
Type of Message
to Log Suboption Type of Message to Log

i Status messages o Out-of-disk-space messages

w Nonfatal warnings p Terminal properties

e All error messages v Verbose output

a Start up actions x Extra debugging info (Windows Server 2000
only)

r Action-specific records + Append to existing log file

u User requests ! Add each line to log

c Initial UI parameters * Wildcard. Log all info except v and x options
(verbose and extra debugging)

m Out-of-memory or fatal
exit information

*vx Log all info including v and x options
(verbose and extra debugging)
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Installing Dragon Medical Client using pre-defined
options in nsdefaults.ini
Once you have Visual C++ installed, you can now use the nsdefaults.ini file you created earlier

in an MSI installation of Dragon Medical Client:

1. Go to the machine you plan to carry out the MSI installation from and copy the files from the

Dragon Medical Enterprise Network Edition Client Software DVD to a location on your network that

you can access all client workstations from.

2. Open a command prompt and switch to the directory on your machine where the setup.exe file

for Dragon Medical Client is now located.

3. Enter the MSI installation command, passing it the options shown below:

msiexec /i "Dragon NaturallySpeaking10.msi" SERIALNUMBER=#####-###-####-

####-## INSTALLDIR="C:\DragonMed" NAS_ADDRESS=10.45.133.91 DEFAULT-

SINI="C:\<full_path>\nsdefaults.ini" /Lwiemo+ "C:\logfile.log" /qn

You must put the name of the .msi file in quotation marks.

Set the INSTALLDIR to the full path where you want the files installed on the workstation.

Set the NAS_ADDRESS to the IP address or machine name of the NMS Server for this particular

Dragon Medical Client.

Set the DEFAULTSINI to the full path to the nsdefaults.ini file you created earlier.

You should include the /L option followed by the full path to an error log file, so that if some-

thing goes wrong during the installation, you receive messages about it. When you pass /L, you

also pass a series of suboptions to have the installation process log both errors and other types of

messages related to the process. (You can then send the log file to Nuance Technical Support

should any issues arise.)

The first time you carry out this installation, you should not pass the /qn option, so that if you

have neglected to provide information about a setting that does not have a default, you receive a

prompt asking for that information. Later, when you are sure this command line works, you can

add the /qn option.

When you generate the MSI command line, be sure to group the Dragon options together after the

/i option, then add the other MSI options at the end of the command line.

To run the installation to a server, you must pass the /a option tomsiexec rather than the /i

option.
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Using command lines in an MSI script
You can use the command lines shown in this section in your own MSI installation script. When

you use the command lines in a script, if you plan to run the script from the directory where

setup.exe resides, you should use the full path to the Visual C++ runtime executable:

\ISSetupPrerequisites\VCRuntime\vcruntime.exe /S /v"/qn /l*v C:\<full_

path>vcruntime.log"

\ISSetupPrerequisites\VCRuntime\vcruntime_x64.exe /S /v"/qn /l*v C:\<full_

path>vcruntime_x64.log"

Summary: Additional MSI options for use with
nsdefaults.ini file
Below is a summary of additional Dragon options you can use when you install Dragon Medical Client

from the command line usingmsiexec.exe.

Additional MSI command line options for using nsdefaults.ini file

Option Function

DEFAULTSINI Set to the full path to the nsdefaults.ini file.

INSTALLDIR Set to the full path to where you want the Dragon Medical
Client to be installed.

NAS_ADDRESS Set to the IP address or name of the NMS Servermachine. If
you have more than one NMS Server, be sure to give the cor-
rect server's address.

/L "<logfilename>.log" Creates a log file where themsiexec installer logs any errors in
the installation. The log file's namemust be in quotation
marks.

172



Chapter 7: Installing Dragon Medical Enterprise Client

Starting Dragon Medical Clients from
Command Line

On any workstation where you installed the client, you can start the Dragon Medical Client from the

command line and login/connect to the NMS Server, as long as you know the login name and pass-

word of the user account on the server:

1. Select Start > Run... and enter cmd in the Run dialog box that pops up.

2. Switch directories to the following path:

<drive>:\Program Files\Nuance\NaturallySpeaking 10\Program

3. Enter the command line shown below, passing either the -user option or the /user option fol-

lowed by the user name and password, in that order. The user name and password must be from

a user account created on the NMS Server:

natspeak.exe /user <username> <password>

4. The password is optional if a provider does not have a password, but Nuance recommends that

you assign all providers using Dragon Medical a password.

5. To log in using a single sign-on user account (when the NMS Server has been set up to run in

Active Directory and the user accounts correspond to Windows user accounts), once the pro-

vider has logged in to Windows, he or she can use the /trusted switch on the command line:

natspeak.exe /trusted

5. You can also use natspeak to install the client from the command line. To receive diagnostic

messages about the Dragon Medical Client installation process, you can use the diagnostic option

shown below:

natspeak.exe /diagnose

When you use the /diagnose option, Dragon Medical sends any information about errors that

occur during the installation into the Dragon.log file.
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Summary: natspeak options in
Dragon Medical Client

You can run the Dragon Medical Client from the command line by running natspeak from the fol-

lowing location on the workstation:

C:\Program Files\Nuance\NaturallySpeaking10\Program\

natspeak switches
You can use the following options on the command line with natspeak to modify the way that

Dragon Medical Client starts up.

Switch Function

/diagnose Runs Dragon Medical Client in diagnostic mode. Outputs infor-
mation into theDragon.log file and exits.

The diagnostic information shown in the log includes file ver-
sion verifications. The diagnostic results endwith a line that
saysDiagnoses: Passed.

/trusted Automatically logs in toDragon Medical Client with the user
account of the logged in Windows user. The user account must
be set up in Active Directory and have a corresponding user
account in the NMS Server.

/user <username> <password> Automatically logs in to toDragon Medical Client with the user
account named. The password is optional if the account does
not have a password. The user account must be set up in the
NMS Server.

Note that Nuance always recommends each user account have
a password.

-user <username> <password> Same as /user.

natspeak command line options
You can use the following option on the command line with natspeak to modify the Dragon Med-

ical Client options settings in the nsdefaults.ini file before installing the client on multiple

machines.

Switch Function

/SetDefaultOptions Opens the Dragon Medical Client'sOptions dialog box, where
you can pre-set the options. When you apply the setting
changes and save them, Dragon saves the settings in the nsde-
faults.ini file.
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Assigning access to folders and
master user profiles across network

Caution:

Windows accounts that all NMS and Profile Optimizer processes on the network run under, even

the Dragon Medical Client, must have read permission to the following:

<Drive Letter>:\Program Files\ folder and all subfolders

Assigning permissions to NMS and Profile Optimizer
component files
To ensure all NMS and Profile Optimizer processes can interact with one another, during the instal-

lation you set up a single administrator level account (name it something like NMSapps) that all

the software will be running under and give full access rights across all servers to the directories

where you install the software. The software these conditions apply to includes:

n NMS Server

n NMC Console

n NMS SQL Database

n Profile Optimizer Server

n Profile Optimizer Database

n Each Profile Optimizer Speech Node

Caution: Run All Services under the same Windows user account

All services should run under this same Windows administrator level account with full access

rights across all servers and the master user profiles directory.

Directories where the components are installed should have full read/write/modify permissions.

Caution: Ensure Full access to the Master user profiles directory

It is especially important that the account that NMS and Profile Optimizer components run under

has complete read/write/modify access to the master user profiles directory. If the servers and

Speech Nodes cannot access the master user profiles, the DME product cannot function properly.

Each windows user account that logs in to the Dragon Medical Client workstation should also have

access to the master user profiles that allows reading profiles and writing to/modifying profiles, an

action the Dragon Medical Client takes frequently to keep profiles current.
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Caution: Regarding Privacy of Patient Data

To protect the privacy of patient data and the integrity of the master user profiles, you should not

give Windows user accounts of Dragon Medical Clients rights to log in to the master user profiles

machine; the Dragon software writes to and modifies the profiles in the background.

Assigning permissions to master user profiles
Caution:

Be sure that when you set up the master user profiles directory, you locate it either on a Windows

machine or on a device connected to a Windows machine with .NET Framework 3.5 SP1

installed on it and that the machine is in the same Windows domain as your DME servers.

To ensure every dictating healthcare provider has appropriate access to files (such as his or her

user profile), you must give full read/write/modify permissions to all files and directories housing

the master user profiles for healthcare providers that dictate on that client or allow the same level

of access to the master user profiles through an http or https connection. This level of per-

mission/access ensures that when the provider dictates, the software can interact with the master

user profiles effectively.

Assigning folder permissions to Dragon Medical
Enterprise server and client files
You must assign particular levels of permissions to certain folders that Dragon Medical Client reads

from and writes to when processing speech.

NMS Servers/NMS and Profile Optimizer Databases:

<Drive Letter>:\Users\All Users\Application Data\Nuance folder and all

subfolders:

All users must have read, write, and modify permissions.

<Drive Letter>:\Program Data\Application Data\Nuance folder and all

subfolders:

All users must have read, write, and modify permissions.

<Drive Letter>:\Program Files\Nuance folder and all subfolders:

All users must have read permission.
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Dragon Medical Client workstations (Windows 7, XP, and Vista):

<Drive Letter>:\Program Data\Nuance folder and all subfolders:

All users must have read, write, and modify permissions.

<Drive Letter>:\<Windows_user_ID>\AppData\ folder and all subfolders:

All users must have read, write, and modify permissions.

<Drive Letter>:\Documents and Settings\All Users\Application

Data\Nuance folder and all subfolders:

All users must have read, write, and modify permissions.

Assigning Dragon Medical Clients access to registry
keys
You must assign particular levels of access to certain registry key settings. You assign these rights

to all Windows user accounts for all dictating healthcare providers using Dragon Medical Client .

Dragon Medical Client workstations:

Workstation Windows user accounts that Dragon Medical runs under must have rights to update the

registry in order to read/write to particular keys in the registry:

HKEY_LOCAL_MACHINE\SOFTWARE\Nuance

HKEY_CURRENT_USER\SOFTWARE\Nuance

Turning off Automatic Updates
On each machine you plan to use in the DME Network, be sure to turn off Windows Automatic

Updates. You should, instead, qualify each update Windows sends by installing it first on a single

test machine of the network and then updating other machines on the network only after you

determine that it clearly will not disrupt the network.

Once you are sure an update does not negatively affect DME, you should install the update during

off-hours and, if required, reboot each machine during those hours to ensure that requests to

reboot do not disrupt the DME servers or workstations during peak hours of dictation.
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Ensuring Dragon Medical Client
anti-virus recommendations are met

Nuance recommends anti-virus software on all Dragon Medical Enterprise Network Edition servers and

clients to protect the system from potential downtime due to viruses. However, on Dragon Medical

Clients, be sure to exclude from the anti-virus scan any files found in the folders indicated below

or with the extensions listed below (on Windows 7, XP, and Vista workstations):

n C:\ProgramData\Nuance\ folder and all subfolders

n C:\<Windows user_ID>\AppData\Roaming folder and all subfolders

n C:\Documents and Settings\All Users\Application Data\Nuance

folder and all subfolders

n C:\Documents and Settings\Windows user_ID\Local Settings\Temp

folder

n Files with these extensions: BD, BIN, DAT, DVC, ENH, GSB, GRM, GRX, INI, LCK,

NWV, SIG, SVC, USR, VER, VOC, WAV, XML, LOG
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Revising or Repairing the Profile
Optimizer Installation

If you have installed the Profile Optimizer Server and/or its Profile Optimizer Speech Nodes and want to

modify or repair that installation, you take only a few steps.

1. Halting Profile Optimizer Speech Nodes on page 180

2. Revising or repairing the Profile Optimizer or Speech Node installation on page 180

Halting Profile Optimizer Speech Nodes
If you have one or more Profile Optimizer Speech Nodes running, you need to terminate their proc-

esses:

1. To terminate the processes, right click on the Start bar in Windows and hold down the mouse

button, then select .Task Manager from the menu.

2. When the Windows Task Manager dialog box appears, click the Processes tab.

3. Find any processes namedNuance.ConversionServer.ClientApp. Highlight them and click

End Process.

Revising or repairing the Profile Optimizer or
Speech Node installation
After the Profile Optimizer Installer wizard starts up and you click Next, if you have already

installed any portion of Profile Optimizer, theModify, Repair or Remove installation page of the

wizard appears and you should selectModify, then click Next to proceed.
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Caution:

After this wizard page, when you are given the option of choosing the parts you are installing, if

you do not select one of the parts (Profile Optimizer Server or Profile Optimizer Speech Node), the pro-

cedure uninstalls the de-selected elements.

Uninstalling NMS Server and NMC
Console

To uninstall the NMS Server and NMC Console:

1. Click Start > Control Panel and open Add/Remove Programs.

2. Find NMS Server in the list and click the Remove button.

Uninstalling Profile Optimizer Server
To uninstall the Profile Optimizer Server component of Profile Optimizer:

1. Halt any Profile Optimizer Speech Nodes that are running.

2. Uninstall the Profile Optimizer Server.

Halting Speech Nodes
If you have one or more Profile Optimizer Speech Nodes running, you need to terminate their proc-

esses:

1. Right click on the Start bar in Windows and hold down the mouse button, then select Task

Manager from the menu.

2. When the Windows Task Manager dialog box appears, click the Processes tab.

3. Find any processes namedNuance.ConversionServer.ClientApp.exe. Highlight them and

click End Process.

Removing the Profile Optimizer database
To remove the Profile Optimizer Database, take these steps:

1. Close all network connections.

2. Click Start > Programs and look for SQL Server Management Studio.

3. When the Microsoft SQL Server Management Studio dialog box appears, expand Databases in

the Object Explorer (to the left) and find the database namedNuancePODB. That is your Pro-

file Optimizer database.

4. Right click onNuancePODB and select Delete from the drop-down menu (see illustration

below).
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Uninstalling Profile Optimizer Server and Speech
Nodes
To uninstall Profile Optimizer Server and/or any Speech Nodes:

1. Click Start > Control Panel and open Add/Remove Programs.

2. Find Profile Optimizer Server in the list and click the Remove button.
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NMS SQL Server backup system
When you look in the SQL Server explorer, to find the NMS SQL Database database, look for a

database namedNuanceMC by default. If you name the database differently during the instal-

lation process, NMS Server retrieves the database name from SQL Server and uses its name as the

root for the backup files.

During the installation process, the NMS Server creates the backup folder in the location you indi-

cate or, by default, in the C:\NMSDBBACKUP folder.

The NMS Server automatically backs up the data you have entered into it on sites, users, groups,

and other objects into the backup folder. It also backs up all Windows communication foundation

service logs that it creates.

(For more information on logs that DME Network clients and servers create, refer to About logs that

DME servers and clients generate on page 188.)

Scheduled NMS transaction log and database
backups
The NMS Server schedules these backups:

n Transaction log backups—Scheduled hourly

n Differential database backups—Scheduled daily

n Full database backups—Scheduled weekly

The NMS Server stores up to one month of backups on its hard disk.

To retain more than one month of backups, you must copy the data before the month is over.

File names of database backups
Each time it carries out a full database backup, the NMS Server takes the following steps:

1. Deletes database files older than 1 month.

2. Renames the NuanceMCDump.BAK file currently in the folder to

NuanceMCDump_YY_MM_DD_hh_mm_ss.BAK, using the current date- and timestamp.

3. Generates a new database backup and names it NuanceMCDump.BAK.
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Profile Optimizer SQL Server backup
system

When you look in the SQL Server explorer, to find the Profile Optimizer SQL Database database,

look for a database namedNuancePODB.

At the beginning of the installation process, you create the Profile Optimizer Server database files

folder and place it on the hard drive of the SQL Server. This file does not require a particular

name, because you tell the server the name of the file later in the installation process. You might

name it something that helps identify it, like ProfOpt_DB. The Profile Optimizer Server auto-

matically backs up the data that it generates into this database files folder.

Note:

The server does not automatically back up Dragon log files and Speech Node service log files that it

creates.

(For more information on logs that DME Network clients and servers create, refer to About logs that

DME servers and clients generate on page 188.)

Automatic Profile Optimizer transaction log and
database backups
The Profile Optimizer Server generates these backups after its Profile Optimizer Core Services

start:

n Differential database backups—Created when the services first start up, then generated daily

n Transaction log backups—Generated hourly as long as Core Services are running

n Full database backups—Generated after Core Services have been running for a full week, then

every time the Core Services have been running a full week since the last full backup

The Profile Optimizer Server stores up to one month of backups on the database server hard disk.

To retain more than one month of backups, you must copy the data before the month is over.

File names of database backups
Each time it carries out a full database backup, the Profile Optimizer Server takes the following steps:

1. Deletes database files older than 1 month.

2. Renames the NuancePODBDump.BAK file currently in the database files folder to

NuancePODBDump _YY_MM_DD_hh_mm_ss.BAK, using the current date- and timestamp.

3. Generates a new database backup and names it NuancePODBDump.BAK.
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Master user profiles backups
The master user profiles file structure follows a particular pattern. Understand this structure can

help you better plan to back up the master user profiles.

Caution:

Nuance recommends that you back up all master user profiles weekly. You should retain these

backups for several weeks in case you need them.

Each Version 10.1 SP1 master user profile is stored in its own subdirectory of the Master User Pro-

files Server (or directory on the NMS Server, Profile Optimizer Server, or database server) as shown

below:

\\<ServerName>\<ProfilesDir>\<NMS_userLoginName>\last known good\

profile1

The first profile for the provider is under profile1. If the provider has more than one profile, the

next is under profile2.

If a profile becomes corrupted, you receive a notification about it in theMessages box on the

NMS Server; the NMS Server moves the profile to the following location:

\\<ServerName>\<ProfilesDir>\<NMS_userLoginName>\BAD\profile1

The next time the provider starts to dictate, the Dragon Medical Client automatically creates a new

profile for that provider.

The corrupted profile remains on the Master User Profiles Server until you remove it. When you

have any corrupted profiles, you should contact Nuance, as these profiles are not automatically

uploaded to the Nuance data collection site. Avoid removing these profiles until Nuance sub-

sequently notifies you that it has retrieved the profiles for analysis.

Restoring corrupted user profile from
backup

If a healthcare provider cannot log in to the Dragon Medical Client, it might be because the master

user profile has become corrupted.

If the profile is corrupted, to restore the last known good copy of the provider's user profile, you

can open the user account for that provider and select the User Profile tab, then click this

button:
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This button not only restores the appropriate profile for the provider, it also moves the corrupted

profile into a BAD directory where Nuance can later retrieve it for examination and analysis.

Removing a master user profile folder
for deleted user account

Before you delete a user account, you should be sure to export the user profile for the account

first. Exporting the user profile saves the information accrued about that particular provider's

voice and speech patterns. Should you ever need that user profile again, you can then import the

exported user profile to bring the provider back up to speed more quickly.

For details on how to export a user profile and delete its associated user account, refer to the

Nuance Management Server Administrator Guide.

After you delete a user profile from the NMS Server (through the NMC Console), the folder for that

provider's user profile remains in the master user profiles directory.

To later reuse the deleted user account's login name for another user account, you must first

remove the original user profile folder with that name from the master user profiles directory. You

can copy it to aDeleted or similar folder, so that you can restore it if the need arises.
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About logs that DME servers and
clients generate

DME Network servers and Dragon Medical Clients generate logs that can help troubleshoot your sys-

tem.

Note:

The servers regularly purge all of these logs and do not automatically back them up, so you might

want to back them up to another location if you want to save them for longer periods.

Dragon and Profile Optimizer Speech Node logs
The Profile Optimizer Speech Node generates two log files for each ACO/LMO task it carries out:

n Dragon log files—Dragon Medical SDK Client creates dragon.log and dgnsetup.log

n Speech Node service log file—Profile Optimizer services write these files

The Profile Optimizer Server stores these files for 30 days. After 30 days, the Profile Optimizer purges

old log files. If you would like to preserve them, you can back them up.

You can view the Dragon log files and Speech Node service log files in the NMC Console.

Viewing Speech Node service logs

To view the Speech Node service log file by taking these steps:

1. On the Menu bar, click the Utilities tab.

2. Click the Profile Optimizer Tasks icon in the Utilities ribbon.

3. Double click on the task of the Speech Node whose log you would like to see.

4. The Profile Optimizer Task Log opens and displays a history of the actions the Speech Node

has taken. For more information, see the View status of scheduled and automatic optimizations section

of the Nuance Management Server Network Edition Administrator Guide.

Viewing Dragon logs

To view the Dragon log files, see the Viewing user account Dragon log files section of the Nuance

 Management Server Network Edition Administrator Guide.

You can also find the Dragon logs in the file system. Note that the location of the files depends on

the operating system. Paths on Windows Server 2008 and on Windows XP are shown below:

Location of Dragon logs on Windows Server 2008:

C:\Users\Administrator\AppData\Local\Temp\dgnsetup.log

C:\Users\Administrator\AppData\Roaming\Nuance\Dragon SDK Client

___Edition10\dragon.log
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Location of Dragon logs on Windows XP:

C:\Documents and Settings\<user_account_login>\Local Settings\Temp\

dgnsetup.log

C:\Documents and Settings\<user_account_login>\Application Data\Nuance\

___NaturallySpeaking10\Dragon.log

NMS Server logs
The NMS Server generates Windows communication foundation service log files for each individ-

ual user account.

Finding NMS service logs

You can find the Windows communication foundation service logs on the NMS Server under a sep-

arate path for each user account:

C:\ProgramData\NMS\Logs\NMS Server\

The service log files are namedNMS Server_0000.svclog toNMS Server_9999.svclog. The

NMS Server keeps the last 10 MB of files generated, or about 50 files, for the entire system. When

it creates new files that exceed those numbers, the server purges the older files.

Viewing NMS service logs

You can view the NMS Server service log files in the Microsoft Service Trace Viewer utility by

double clicking on the log file. (The utility is available in .NET Framework.) Or you can open the

Service Trace Viewer by double clicking its executable, available at:

C:\Program Files\Nuance\NMS Server\SvcTraceViewer.exe

If you run the Service Trace Viewer from its executable, when first you select File > Open, you

must browse to the location of the log files. The next time, the viewer remembers the path.

If you call Technical Support, you might be asked to provide one or more of the logs mentioned

in this section to help Nuance engineers work on any issues with your DME Network.
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Setting up NMS Server to run in
Active Directory Services

If you want to use Active Directory to manage your Dragon Medical Enterprise (DME) Network, you

need to decide up front, before you proceed with this installation, because correctly setting up

NMS Server to work with Active Directory Services means taking particular steps at different

points in the installation process. Those actions and the additional actions at each step are out-

lined below:

n Installing SQL Server 2008:

l SelectMixed Mode authentication for accessing database.

n Creating NMC Administrator Account in NMS Server for Active Directory

Administrator:

After you install the NMS Server:

l Install the Nuance Certificates on any workstation where you want to log in through the

NMC Console. (Refer to the Dragon Medical Enterprise Network Edition Installation Guide.)

l Log in to NMS Server using the admin login Nuance provides.

l Prepare to create user accounts by changing the name of the organization/site Nuance pro-

vides to match your organization and site.

l Create anNMC Administrator user account for the Active Directory administrator.

l If you would like, create all other user accounts now; or you can create user accounts later.

l Create Single Sign-On User Accounts: If you want to set providers up to log in only

once, you can set up Single Sign-On user accounts (they are optional). You need to create

these accounts before you can associate a user account with an already existing upgraded

master user profile.

n Enable Active Directory and set the connection string:

l Log out of the NMS Server.

l Shutdown the Nuance Management Service.

l Configure yourNMS Server for Active Directory.

l Restart the Nuance Management Service.

l Log back in through the NMC Console using the Active Directory administrator user

account.

n Continue to Configure NMS Server as Active Directory Administrator:

l Follow instructions in Nuance Management Server Administrator Guide.
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Selecting Mixed Mode authentication during SQL
Server installation
During the SQL Server installation, on the Database Engine Configuration page of the wizard,

when you choose the type of authentication required to access the database, selectMixed Mode.

SelectingMixed Mode ensures that you can later attach to the database using an Active Directory

account.

Creating NMC Administrator for Active Directory
administrator
To create the NMC Administrator account for the Active Directory administrator:

1. Install the NMS Server following the instructions in this manual.

2. Log in to the NMS Server through the NMC Console.

3. To prepare to set up user accounts required for Active Directory in NMS Server, you need to

first:

l Change the name of the default organization to your organization's name. See details on mod-

ifying the organization information in the Nuance Management Server Network Edition Admin-

istrator Guide under Accessing and adding to your organization data.

l Change the name of the default site in that organization to your site's name. See details on

how to create a site in the Nuance Management Server Network Edition Administrator Guide under

Configuring sites in DME

4. Create anNMC Administrator user account for the Active Directory administrator to use

when logging in to the NMS Server. Be sure the login you assign in NMS Server matches an exist-

ing login in Active Directory. See Creating NMS Server user account for Active Directory administrator

on page 197 for details on setting up this particular administrator user account.

5. Assign anNMC Administrator license to the new account for the Active Directory admin-

istrator.
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6. You can create other user accounts at this time, but if you are not ready to create them, you can

create them later, as long as every NMS Server user account login you assign matches an existing

login in Active Directory.

7. Proceed to the next subsection.

Enabling Active Directory and setting the
connection string
You enable Active Directory forNMS Server and set the Active Directory connection string by

editing a file on the NMS Server calledNuance.NAS.Server.exe.config:

1. Log out through the NMC Console and shut down the NMS Server by

stopping its service:

In the Control Panel,double click Administrative Tools. Then double click Services. In

the Services window, find the Nuance Management Service and stopthe service.

Find the Nuance.NAS.Server.exe.config file in the directory where you installed yourNMS

 Server. The default location for the file is under C:\Program Files\Nuance\NMS

 Server\.

2. Edit the file in a text editor and find the section shown below:

<appSettings>

<add key="DumpFileLimitMB" value="50" />

<add key="MaxMessagesPerDump" value="1000" />

<add key="ClientSettingsProvider.ServiceUri" value="" />

<add key="FileStorePath" value=""/>

<add key="FileStorePurgerAgeCriteriaMinutes" value=""/>

<add key="FileStorePurgerCompletedFolderAgeCriteriaMinutes"

value=""/>

<add key="ActiveDirectoryConnectionString" value=""/>

</appSettings>

3. To turn on Active Directory, set the ActiveDirectoryConnectionString to the appropriate

value for your network. Usually that value is something like LDAP://<servername> , where the

server is the one where Active Directory is installed, as shown below:

 < add key = "ActiveDirectoryConnectionString"

value= "LDAP://ActDirServer"/>

4. If you leave the ActiveDirectoryConnectionString value blank, then Active Directory feature

remains off. Once you turn on Active Directory, after you restart the server, the change takes

effect.

Once Active Directory is on, the NMS Server sends all authentication requests to the server you

specified in the connection string value. You can then take actions to set up and manage your

DME network using Active Directory Services. For information on using Active Directory Serv-

ices, refer to the documentation Microsoft provides.

For the enabling of Active Directory to take effect, you need to restart the NMS Server.
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Restarting the Nuance Management Service
1. Restart the NMS Server by restarting the service: In the Control Panel,double click Admin-

istrative Tools. Then double click Services. In the Services window, find the Nuance

 Management Service and restart it.

2. Log in to the NMS Server using the new NMC administrator user account you created for the

Active Directory administrator.

3. Revoke the NMC administrator license of the original admin user account that Nuance pro-

vided, since that account does not work within Active Directory. You might want to grant that

license to another user account.

4. If you would like dictating healthcare providers to be able to log in to Windows and then auto-

matically be logged in to the Dragon Medical Client on the same workstation without having to

enter separate login credentials for Dragon, follow the instructions in the next section, Imple-

menting Single Sign-On.

Setting up providers to log in only once by creating
Single Sign-On user accounts
If you would like dictating healthcare providers to be able to log in to Windows and then auto-

matically be logged in to the Dragon Medical Client on the same workstation without having to enter

separate login credentials for Dragon, you can implement a feature of DME called Single Sign-On.

This feature helps administrators and providers avoid having to enter their login and password mul-

tiple times.

Before creating Single Sign-On user accounts

Before you create Single Sign-On user accounts, you must:

n Configure yourNMS Server to use Windows Active Directory Services as explained earlier.

n Be sure you have a parallel Active Directory accounts for every administrator or dictating

provider before you set up that individual's NMS Server account.
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Creating Single Sign-On user accounts

To create Single Sign-On user accounts for all dictating healthcare providers:

Note:

A quick overview of creating user accounts for providers is available in Creating user accounts for

healthcare providers on page 117. For more on setting up user accounts, refer to Nuance Management

Server Administrator Guide under Configuring groups and user accounts.

1. During the process of creating provider user accounts in the NMS Server, be sure to assign a

login name that matches the provider's Windows Domain user name (see the next illustration).

2. In your script (or shortcut), include this line: natspeak.exe /trusted

Once you have set up the user accounts this way, and the DME servers and workstations are run-

ning, providers do not have to enter their login credentials to run Dragon Medical Client. After the

provider logs in to the Windows desktop, the Dragon Medical Client opens and establishes contact

with the NMS Server, then the server makes the appropriate information available.
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Note:

If Single Sign-On is not successful, the Dragon Medical Client prompts the provider to enter an

Active Directory login and password.

Continuing to Configure NMS Server as Active
Directory administrator
To continue to configure the NMS Server as Active Directory administrator, follow the instruc-

tions in the Nuance Management Server Adminstrator Guide.

Creating NMS Server user account for
Active Directory administrator

When you are planning to work in Active Directory, one of the steps you take is to create an

NMS Administrator account for the Active Directory administrator.

Note:

More details about creating user accounts are available in the Nuance Management Server

Administrator Guide.

To create anNMC Administrator account for the Active Directory administrator:

1. Log in to the server through the NMC Console. For details, see Logging in to the NMS Server

through the NMC Console on page 77.

2. On the Menu bar, click on the User Accounts ribbon.

3. When the User Accounts ribbon appears, click the Add User Account icon.

The User Account Details window opens.
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4. Configure the options and settings on tabs in the User Account Details window:

l Details—Enter data in the shaded text boxes, as that data is required. You can fill in the

others later. Required information includes the Active Directory administrator's first and

last names and the login.

Caution:

The login you enter must match a login that exists in Active Directory.

l Address—Physical location information. None of this data is required right now. You can

fill it in later.

l Group Memberships—If you have created no other groups, two groups exist when you

first run the product, NMC Administration and Dragon Medical. Add the Active

 Directory administrator to the NMC Administration group.

l Dragon Settings—To apply default settings for now, click the Use group rules button.

For more information, refer to Configuring user account Dragon settings in the Nuance Management

Server Administrator Guide.

l User Profile—Ignore these settings. The Dragon Medical Client provides them.

5. Click Save to save the user account settings.

6. When you save the user account, the NMC Console pops up a dialog box that asks you if you

want to assign a license to the user account now.
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You should click Yes.

7. When the next message asks you the type of license to assign, you select anNMC

 Administrator license. The number of licenses available shows in parentheses after the license

type. If no licenses of a particular type are available, that type of license is grayed out. If no

administrator license are available, contact your Nuance representative.

8. Return to the Active Directory configuration instructions under Setting up NMS Server to run in

Active Directory Services on page 192.

Note:

For now, you can skip setting options and other information for the user accounts

that you want to associate with upgraded master user profiles. To later assign all

related user accounts the same option settings, you can:

n Create a group and set all options for that group.

n Add the user accounts that should have the same options to the group.

For details on how to carry out these tasks, refer to the Nuance Management Server

 Administrator Guide.
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